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IMPORTGEO SUBMODULES 

The three ImportGeo submodules can handle and import most 2D and 3D image file 
formats into GeoDict.  

◼ ImportGeo-Base loads structure files with a GeoDict file format. For more 
information, check the ImportGeo-Base handbook of this User Guide. 

◼ ImportGeo-Vol is used to import most image file formats for 3D visualization, 3D 
image processing and segmentation. On imported gray value images, ImportGeo-
Vol can perform 3D processing with a variety of filtering techniques. Subsequent 

segmentation converts gray values to material index values typically stored in the 
GeoDict Binary file format.  

◼ ImportGeo-CAD imports surface triangulation files that describe only the surface 
geometry of a three-dimensional object. During import, these files can be 

converted to 3D material models. For more information, check the ImportGeo-
CAD handbook of this User Guide. 

The three ImportGeo submodules import the following file formats: 

 

ImportGeo 

submodule 
File formats 

ImportGeo-

Base 

GeoDict Binary 

(*.gdt) 

GeoDict Analytic 

(*.gad) 

GeoDict ASCII 

(*.leS) 

GeoDict 32BIT 

(*.g32) 

ImportGeo-

Vol 

1, 2 or 4 Byte 

Integer (*.raw) 

4 Byte Float 

(*.vol) 

GeoDict Raw File 

(*.grw) 

GeoDict Binary 

(*.gdt) 

GeoDict ASCII 

(*.leS) 

GeoDict 32BIT 

(*.g32) 
Rek File (*.rek) 

Zeiss 3D Image 

(*.txm) 

Avizo Binary File 

(*.am) 

WiseTex Vox File 

(*.vox) 

IASS File 

(*.iass) 

TIF Image File 

(*.tif) (*.tiff) 

BMP Image File 

(*.bmp) 

CUR Image File 

(*.cur) 

GIF Image File 

(*.gif) 

ICO Image File 

(*.ico) 

JPEG Image File 

(*.jpeg) 

JPG Image File 

(*.jpg) 

PBM Image File 

(*.pbm) 

PGM Image File 

(*.pgm) 

PNG Image File 

(*.png) 

PPM Image File 

(*.ppm) 

SVG Image File 

(*.svg) 

SVGZ Image File 

(*.svgz) 

XBM Image File 

(*.xbm) 

XPM Image File 

(*.xpm) 
  

ImportGeo-

CAD 
STL File (*.stl) OBJ File (*.obj)   

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoBase&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoCAD&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoCAD&release=2023
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IMPORTGEO-VOL 

To convert volume and image formats, such as µCT-scans, into 3D material models, 
select Import → ImportGeo-Vol in the menu bar. The ImportGeo-Vol section 

opens at the left of the GeoDict GUI. 

 

 

 

 

 

 

 

 

 

 

 

Clicking Browse opens the Select File dialog to locate a file or an image stack in the 

chosen project folder. Select the filename and click Open.  

 

 

 

 

 

 

 

 

 

 

 

In the Geometry Import dialog, for most formats, the size of the file’s structure is 

automatically entered. 

The amount of approximately required memory and free memory are displayed and 

indicate the amount of working memory available. 
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At the bottom, the Quick Segmentation, and Image Processing buttons can be 

clicked: 

◼ Quick Segmentation: For many of the importable file formats, the structure 
appears in the visualization area after clicking Quick Segmentation. 

For other files, such as *.raw image files, or stacks of *.png files, that are 
considered a three-dimensional image with gray values (e.g., from 0 to 255), 

clicking Quick Segmentation opens the 3D Image Quick Segmentation dialog. 
This dialog shows a histogram with the number of voxels for each of these gray 
values and enables a simple global segmentation without further 3D Image 

Processing. For more information see Quick Segmentation for 3D images with 
ImportGeo-Vol on pages 14ff. 

◼ Image Processing: allows more complex image processing through which images 
can be cut, resized, rotated, and segmented by thresholding and filtering. For more 
information see 3D Image Processing in ImportGeo-Vol on pages 18ff.  

After selecting the file format to be imported, click Browse… to locate the file. 
Depending on its file format, a dialog opens containing various options and 

parameters defining each file format, in preparation for the import. 
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The available units (m, mm, µm, nm and Inch) are selectable from the pull-down 

menu at the top right of every dialog. 

At the bottom of every dialog, the voxel size in the desired unit can be defined in 

Voxel Length. Voxel Length and the size of the selected image of the structure in 
voxels (NX, NY, NZ) are shown for all the formats for import.  

NX, NY, and NZ specify the size of the structure in voxels. For most file types, these 
values are entered automatically. For RAW format files (*.raw), you need to know 
these values and enter them here. For *.gad files (GeoDict Analytic Data), they can 

be arbitrarily defined. 

The double sliders allow restricting the portion of the 3D image to be loaded. The left-

hand sliders define the number of voxels which are cut away at the start of the image 
in each direction, and the right-hand sliders define the last voxel to be imported in 
each direction. 

By default, ImportGeo imports the complete image from the hard drive. The values 
for NX, NY, and NZ, and the first and last voxel positions might be changed for very 

large images that would not fit in memory. It is possible to focus on any sub-cuboid 
of the original image by adjusting the sliders. 

Check Keep existing Volume Fields, if the loaded volume fields should not be 

discarded. This is only recommended, if they have the same dimensions as the gray 
value image to load. Otherwise, a dialog shows up after clicking Image Processing, 

asking if the structure and volume fields should be discarded. 

For most importable file formats, the size parameters are automatically entered after 
browsing for the file and loading it. Clicking Quick Segmentation brings in the 

structure saved in the selected file, so that it is displayed in the visualization area. 

All file formats listed above can be processed (i.e., the objects in the structure can be 

cut, resized, rotated, thresholded, and filtered) before the file is finally imported into 
GeoDict.  

 

 

Browse for file to import 

Parameter values are automatically 
or manually entered 

Click Quick Segmentation to load  

and visualize the structure directly 

Click Image Processing  

for 3D image processing and 
advanced segmentation capabilities 
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FILE FORMATS FOR IMPORTGEO-VOL 

The following pages describe the import of most of the file types that can be imported. 

1,2, OR 4 BYTE INTEGER (*.RAW) 

The RAW format describes grayscale three-dimensional (or volume) images. In a RAW 

image file, the Header Size specifies the length of the header of the selected image 
file in bytes. A typical convention for Header size is 2048. A RAW file is a simple 

binary file, in most cases, without header information. A RAW file is created, e.g., 
when taking tomographic images. Thus, the creator of a RAW file must provide the 
information on the size needed for import, as it should be provided from the person 

taking the tomography. 

For a file containing a three-dimensional image with NX by NY by NZ voxels with 

format Int, the file consists of either Header Size + 1 x NX x NY x NZ bytes, Header 
Size + 2 x NX x NY x NZ bytes or Header Size + 4 x NX x NY x NZ bytes.  

The position of the byte (or 2 bytes or 4 bytes) in the Int file determines the position 

of the corresponding voxel. In case of a single byte (or 8-bit images), all gray values 
from 0 to 255 may be present. In images with 2 bytes per voxel (or 16-bit images), 

gray values from 0 to 65535 can be represented. Finally, images with 4 bytes per 
voxel (or 32-bit images) can represent roughly 4 billion gray values. 

 

If the RAW file to load contains floating point values, in the Geometry Import dialog 
select Float from the pull-down menu for Format. For images in float format the file 

can consist of either Header Size + 4 x NX x NY x NZ bytes or Header Size + 8 x 
NX x NY x NZ bytes. 

 

 

Define whether the binary data in the selected file is stored in Big Endian byte order. 
If not checked, GeoDict assumes that the image is stored in Little Endian byte order. 

If an image is stored by a big endian system, the most significant bytes are stored at 
the smallest memory address. For more details about endianness refer to the 

Wikipedia page.  

The information about how the bytes of the image are stored must be provided by 

the creator of the RAW file.  

GeoDict cannot automatically retrieve the dimensions of an image saved in RAW 
format. The parameters NX, NY and NZ and the Header Size must be known before 

loading the file. 

In case the user simply clicks Quick Segmentation or Image Processing in the 

Geometry Import dialog after browsing for a *.raw file, a warning appears stating 
that the file length does not agree with the entered size.  

 

In the following, the Berea sandstone of [1] is used in an example to describe the 
workflow before segmenting or processing the image.  

https://en.wikipedia.org/wiki/Endianness
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Here, with the values of NX=1024, NY=1024 and NZ=1024, the file length with the 

Header Size (50) comes up to 1,073,741,874 bytes (Header size + NX x NY x NZ = 
50 + 1024 x 1024 x 1024) in case of an 8 bit image, but this is incorrect, since the 

actual header size is 0 and, as a result, the .raw file is not loaded.  

 

 

 

 

 

 

 

 

 

 

 

 

 

A warning appears comparing the selected file size and the calculated byte size with 

respect to the input values for 8 bit and 16 bit integer values. The Warning suggests 
an input value for Header Size, which is necessary for *.raw files with header 

information. Values up to 2048 (bytes) may typically be expected here. If there are 
no good suggestions for the header size, probably the volume dimensions of the scan 
were given incorrectly. In the example below we obtain the correct suggestion 0 for 

the header size for the 8bit image. 
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It is a recommended habit to include file dimensions and voxel size in the name of 

.raw files. Accordingly, the correct values are here extracted from the file name of the 
Berea sandstone structure BereaSandstone_1024_1024_1024_0.74mu.raw. In other 

cases, the taker of the tomography provides the correct values in an additional 
readable file or as header of the raw file, so that the values can be extracted using a 

text editor (e.g., Notepad++).  

Click Quick Segmentation to segment the image without image processing, as it is 
described on pages 14ff. Click Image Processing to open the image in the 3D 

Image Processing dialog, which is described on pages 18ff.  
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4 BYTE FLOAT OR INT (*.VOL) 

VOL files are 3D image data files with variable length header. GeoDict assumes VOL 
files to contain floating-point representations of three-dimensional (or volume) 

images. The import dialog also offers the option to import 32 Bit Integer values. 

The ordering of the information is the same as for the RAW file format and, as in the 

RAW file format, a file header may be present. 

Different from RAW files, always 4 bytes are used in the representation of the image, 
and these 4 bytes may be read as floating-point number or integer value. Like in the 

RAW files, the Header Size, the number of voxels (NX, NY and NZ) and the Voxel 
Length are not contained in the file and must be entered in the Geometry Import 

dialog by the user before importing.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Some other software packages do not follow GeoDict’s naming scheme, and produce 
VOL files with integer values in them, usually with 16-bit information. Should the user 

have trouble importing VOL files and suspect that the file contains integer data rather 
than floating point data, it might be useful to try and change the Format option (see 

image above) to Int type and then import the file with ImportGeo. 

In the Geometry Import dialog, the imported structure can be chosen to be in 

format Float (floating point) or Int (integer). 

Click Quick Segmentation to segment the image without image processing, as it is 
described on pages 14ff. Click Image Processing to open the image in the 3D 

Image Processing dialog, which is described on pages 18ff.  
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GEODICT FILE FORMATS (GRW, GDT, LES, G32) 

For the import of the GeoDict file formats GRW (GeoDict Raw), GDT (GeoDict Binary), 
and G32 (GeoDict 32BIT) the dimension parameters and the voxel length are 

automatically read from the file.  

For the import of LES files (GeoDict ASCII) the Voxel Length must be entered. 

 

 

Click Quick Segmentation to segment the image without image processing, as it is 

described on pages 14ff. Click Image Processing to open the image in the 3D 
Image Processing dialog, which is described on pages 18ff.  
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OTHER 3D DATA FILE FORMATS (REK, TXM, AM, VOX, IASS) 

For the import of REK files (Fraunhofer), TXM files (Zeiss), AM files (Avizo), VOX 
files (WiseTex) and IASS files (Fraunhofer), the dimension parameters and the voxel 

length are available from the header of the file and are automatically read from the 
file.  

REK files are reconstruction files from Fraunhofer containing data from 3D computer 
tomography. 

 

IASS files are the native 3D image data format of the Fraunhofer ITWM’s MAVI 
(Modular Algorithms for Volume Images). 
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IMAGE FILE FORMATS (TIF, BMP, CUR, GIF, ICO, JPEG, JPG, PBM, PGM, 

PNG, PPM, SVG, SVGZ, XBM, XPM) 

Single 2D images or complete structure data consisting of a stack of 2D images, in 
any of the importable image formats, can be imported using ImportGeo-Vol. The 

images in a stack form layers in the XY-plane. Then, each of the images is one layer 
in the Z-direction. TIF-images in 3D-format can also be imported.   

To import a single image or a stack of images, in an importable image format, select 

that format from the pull-down menu. Click Browse and select one of the files in the 
stack of interest.  

 

After clicking Open, the Geometry Import dialog opens.  
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The dimensional values in the X and Y-direction are automatically filled in for all image 

type files, but they can be changed to import only a part of the single image or 
structure (Crop X, Crop Y). The default voxel length must be changed to the one in 

the resolution data provided with the stack of CT images. All images in a stack must 
have the same resolution. 

If not all images in the selected folder should be imported uncheck Import all Files 
in Folder. Then, the relative path to the image file and its name displays in the field 
Image Name(s). Adjust the Image Name(s), and the values for Number First 

and Number Last.  

For the import, the images must be given as a stack of files, with the same file name 

followed by numerically correlated numbers.  

Checking Import all Files in Folder has the same effect as: 

a. changing the numbers in Image(s) Name by as many ”#”s as the image 
number (e.g., 001 = ###) and  

b. entering the first image and last image number values for the range of images 
to load.  

In the following the number of imported images is changed with the parameters 
Number First and Number Last to import a single image file, a range of image files, 

or the complete stack of image files to form a structure, segmented with Quick 
Segmentation. 
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Click Quick Segmentation to segment the image without image processing, as it is 
described on pages 14ff. Click Image Processing to open the image in the 3D 

Image Processing dialog, which is described on pages 18ff.  
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QUICK SEGMENTATION FOR 3D IMAGES WITH IMPORTGEO-VOL 

Images are loaded with ImportGeo-Vol by clicking Quick Segmentation in the 
Geometry Import dialog.  

When the 3D image can be read properly (e.g., the image dimensions must be set 

correctly in case of a RAW format as described on page 5), this opens the 3D Image 
Load dialog. 

The Berea sandstone of Andrä et al. 
(2013) is used here to describe the 
workflow when following the Quick 

Segmentation button. For non-
binary 3D image scans, it is highly 

recommended to continue with 
Image Processing as described on 
pages 18ff., which also enables to 

use the entire range of 
segmentation capabilities in 

GeoDict. 

 

 

 

In the dialog, the 3D image can be manually segmented via global gray value 

threshold(s) without opening the 3D Image Processing dialog.  

 

https://doi.org/10.1016/j.cageo.2012.09.005
https://doi.org/10.1016/j.cageo.2012.09.005
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For the segmentation, first the Number of Thresholds may be defined. If the 

information is available, the constituent materials for the segmented material phases 
can also be set (e.g., Water and Quartz). The gray value thresholds between the 

chosen materials may be adjusted by entering a number or moving the slider left and 
right. The histogram shows the gray values (from 0-255 in case of 8-bit images) on 

the X-axis and the frequency of corresponding voxels on the Y-axis logarithmically. 
Typically, peaks indicate different materials. However, often peaks are not easily 
distinguished from each other. Please see the Image Processing section on page 

18ff to learn more about distinguishing materials by filtering 3D images.  

 

In the 3D Image Quick Segmentation dialog in the example above, pore space and 
solid fraction may be distinguished with a threshold at 115.5. Then, clicking 
Segmentation segments the image. The file information is processed, and the file is 

imported and visualized in the Visualization area of the GeoDict GUI. 

The 2D View visualization shows Quartz grains and pore space. However, a great 

amount of noise is visible in the image, meaning that solid voxels are wrongly located 
in the pore space and vice versa. Thus, this 2D View visualization hints at the need 
for a proper Image Processing. In general, if threshold values are not known a 

priori, it is recommended to continue with Image Processing instead of clicking 
Quick Segmentation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ImportGeo submodules – ImportGeo-Vol 

16  GeoDict 2023 User Guide 

In the following, the Quick Segmentation feature is explained on another sample 

(see also Single 2D images above). After clicking Quick Segmentation, the gray 
values in the image file(s) can be assigned to Material IDs (and their colors) for 

visualization in GeoDict. It is possible to set up to 15 thresholds.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After setting these thresholds, clicking Segmentation loads the cutout specified in 
the Import Geometry dialog.  

Move the threshold value sliders around before loading the stack of images and see 
the Image Segmentation section on pages 80ff for more information on 
thresholding values.  
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3D IMAGE PROCESSING IN IMPORTGEO-VOL 

Advanced 3D Image Processing is available for all file formats imported with 
ImportGeo-Vol. Images can be cut, resized, rotated, filtered, and segmented by 
different methods. This processing is not available for files imported with ImportGeo-

Base (GeoDict format files) or ImportGeo-CAD (STL format files). 

To process an image file or a stack of image files for import, click Browse…, find 

them, fill in the needed parameters in the Geometry Import dialog, and then click 
Image Processing.  

See above on page 1, the table of file formats to import and a more detailed 

description on importing specific data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After clicking Image Processing, the gray value image is loaded as a volume field 
in the GeoDict visualization area, and the 3D Image Processing dialog opens.  

If Keep existing Volume Fields is selected and a structure or volume fields with 

dimensions different to the loaded gray value image are in memory, a message dialog 
appears, asking if the loaded structure and volume fields should be kept in memory. 

If clicking Yes, they are kept, and the gray value image is loaded additionally. If 
clicking No, they are discarded from GeoDict. 
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All steps done in the image processing tab are not only visualized in the 2D Slice 

Visualization area in the 3D Image Processing dialog, but also in the main GeoDict 
GUI, where the view can also be switched to 3D by selecting View → 3D Rendering. 

A short introduction on visualization in GeoDict can be found on pages 83ff and for 
detailed information refer to the Visualization handbook of this User Guide.  

The different sections of the 3D Image Processing dialog provide various tools for 

individual image processing and segmentation. 

◼ The Menu bar at the top offers a quick access to the File, View, Image Processing 

and Segmentation & Labeling pull-down menus. 

◼ The quick access bar for View Options shows often required view settings. 

◼ The 2D Slice Visualization section shows the image scan in all three directions. 

◼ The Histogram section contains image statistics and related view settings.  

◼ The Status section displays the image size and resolution and the intermediate 

results from different applied filters. 

◼ The Workflow Manager displays all steps of the Image Processing workflow. 

◼ The Image Processing and Segmentation section contains two tabs. 

◼ The Image Processing tab contains all available tools for cropping, resizing, 
rotating and filtering the gray value images. 

◼ The Segmentation & Labeling tab contains all available tools for 
segmenting and labeling the gray value images. 

 

 

 

 

Clicking Undo Processing Step, located below the Image Processing and 

Segmentation panel, reverses the last image processing step. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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The image processing can be aborted either by clicking Discard Image or by clicking 

Close Dialog. 

Discard Image closes the dialog and removes the gray value image from the 

memory and thus, from the GeoDict visualization area. 

Close Dialog only closes the dialog, while the gray value image is still in memory 

and shown in the visualization area. 

Otherwise, the dialog stays open, even after segmenting or labeling an image.  

The processing of files for import can be done in several steps. The user simply applies 

different processing tools in the Image Processing tab and then moves to the 
Segmentation and Labeling tab to segment the image with the chosen method or 

label the image with the watershed algorithm.  

Then a result file (.gdr) for the image processing and segmentation/labeling is created 
and the segmented (.gdt) structure or labeled (.g32) image is saved in a new folder 

according to the given Result File Name as described on page 80. New and improved 
3D models can be created anytime by using different processing, segmentation, or 

labeling parameters. 

 

STATUS SECTION 

The status section shows the image size. i.e. the number of voxels in X-, Y- and Z-
direction and the voxel length.  

The Dataset pull-down menu contains the current processed image and the last step. 
Selecting it from the pull-down menu loads the corresponding image in the Image 
Processing dialog.  

 

Additionally, it can contain different images loaded to the Image Processing dialog 
while having Keep existing Volume Fields selected in the Import Geometry 

dialog, as described on page 4. Thus, the user can easily switch between several 
images, that are loaded simultaneously.  

 

 

 

 

.  
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MENU BAR 

From the menu bar in the 3D Image Processing dialog, File options are accessible 
offering options to store the image as 2D image slice(s) or as 3D image data, or to 

back-up the current processing status of the gray value image. The View menu tree 
contains many of the available view settings. The other two tabs lead to all available 

Image Processing and Segmentation & Labeling tools.  

 

 

 

FILE 

From the File menu, the image can be saved as 2D Image Stack or 3D Image. This 
way, the processed images also can be saved again as grayscale data before (or 
instead of) importing them in GeoDict. 

 

 

 

 

 

SAVE AS 2D IMAGE STACK 

The 2D images shown in the 2D preview areas can be saved as a stack of 2D images 
corresponding to one of the directions (X, Y, or Z). Select to save the whole stack of 

2D images (All), some of them (Interval) or just one of them (Single Image). After 
clicking Save 2D Images, the user creates and/or selects a folder where to save the 
2D images. 

 

 

All slices may be saved as 2D Images either in 8-bit PNG file format or as 8-/16-bit 
TIFF files depending on the data. Note that 32-bit image data is converted to 16-bit 

upon import and will thus also be exported as 16-bit TIFF files. 

The names of saved 2D images contain the selected direction, the slice number, and 
start with either the folder name or a prefix when choosing Give Image Prefix. 

The slice thickness is one voxel length. 
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If Interval is selected, (for example, here 

42), images in Z-direction are saved as 2D .tiff 
files in the afterwards chosen folder.  

The images are named from “CT-
image_Z00001.tif” to “CT-image_Z00042.tif”. 

 

 

 

 

 

Also, a Single Image may be saved as 2D 

image.  

For example, here, slice 42 on the Y-direction 

would be saved as .png image. 

 

 

 

 

As another example, here, twenty 2D images in Y-direction are saved in the folder 
Middle Stack. The names of the twenty saved .png images contain the folder name, 
the selected direction, and the slice number.  

 

 

 

 

Additionally, a GeoDict result file (*.gdr) with the same name as the selected folder 
is saved to the current project folder containing information about the applied filters 
and the original image dimensions. Open the result file in the Result Viewer by 
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selecting File → Open Results (*.gdr) from the menu bar in the GeoDict main 

window. 

 

 

SAVE AS 3D IMAGE 

3D images can also be saved in a single 3D data file as: 

◼ GeoDict Raw File (*.grw),  

◼ 8- or 16-Bit 3d Gray Value Image (*.tif),  

◼ 8- or 16-Bit Integer Raw Data (*.raw),  

◼ 32 Bit Integer Raw Data (*.raw) if necessary 

◼ DICOM File, Multi-Frame (*.dcm) 

◼ DICOM File, Zipped (*.dmz). 

 

After clicking Save 3D Image, a file name for the file in RAW format must be entered 

before clicking Save. Here it is 3D_rawImage: 
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In case of storing the data in the GeoDict .grw file format, there is also the option to 
compress the image or to label the stored volume field.  

If Compress is checked, the raw part of the image is compressed. Thus, the image 
data is compressed, while the header stays uncompressed. 

To define the Image Label and the Field Name, check Give Image Name. This 

label and the field name are visible e.g., when loading the gray values into GeoDict 
as volume field. Then the name appears in the Project Status section and as a title 

of the gray value legend. If Give Image Name is not selected, the default names 
Image and Gray Values are used for that purpose.  

 

A *.grw file is a GeoDict Universal File with a standardized header describing the 3D 

data format. This header may be read with an editor such as Notepad++. 

Additionally, a GeoDict result file (*.gdr) with the image name is saved to the current 

project folder containing information about the applied filters and the image 
dimensions. Open the result file in the Result Viewer by selecting File → Open 

Results (*.gdr) from the menu bar in the GeoDict main window. 
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VIEW 

The View menu contains all available options for representation of the gray value 
image as 2D slices in the 2D Slice Visualization section.  

 

 

 

 

 

 

 

 

 

The View Mode allows selecting between Tile View and Stacked View. 

 

With the Tile View, the three 2D slices (for the X-Y, the X-Z, and the Y-Z planes), 
and the histogram section are displayed as shown in the screenshot of the 3D Image 

Processing dialog on page 19.  

In the Stacked View, only one of the 2D slices or tabs of the Histogram is displayed. 
Here, the user may focus on either of these by choosing the desired visualization from 

the available tabs. 
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The selection in Axes controls the display of the lines giving orientation in the 2D 

image slices.  

 

 

 

For Synced, the lines show the intersection of 
the two remaining directional axes in RGB 
colors interactively, as shown in the screenshot 

on the right. 

For Centered RGB, the lines always are 

displayed in the center.  

For None, the lines are invisible. 

 

 

 

From the View menu, the Main Plane may be set. This choice affects 
only the visualization in Tile View. The chosen plane is shown on the 
upper left (here, YZ) and the order of the axes is changed according to 

the choice. 

Checking or unchecking Show Coordinates controls if the legend in the upper left 

corner is displayed. It contains the information of plane and slice on the preview areas 
for the three directions. 

 

 

Outline Segmentation refers to the representation of the thresholding settings and 

is explained in more detail later in the Image Segmentation section on pages 80ff. 

Use GeoDict Custom Colors changes the colors of the representation of the 

thresholding settings for the image segmentation to the colors that are currently 
defined in the GeoDict GUI. The Color Settings are available from Settings → Color 

& Visibility Settings in the GeoDict GUI menu bar: 
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When the Auto Collapse Tree option is checked, the user only sees in the Image 

Processing and Segmentation section (left of the dialog), the feature currently 
chosen from the Image Processing or Segmentation & Labeling menu. All other 

tree paths are collapsed automatically after another selection in the respective tab for 
convenience and simplification. 

Checking Sync Scrollbars synchronizes the 2D slices in the Tile View when scrolling 
the excerpt up and down or left and right. 

IMAGE PROCESSING 

The Image Processing menu is an 
overview of the 3D Image Processing 

tools in GeoDict. 

When clicking on the names of the 
various feature, the user is forwarded 

directly to the according tool, filter, or 
thresholding method in the Image 

Processing tab to the left of the 3D 
Image Processing dialog. 
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SEGMENTATION & LABELING 

The Segmentation & Labeling menu is an overview of the 3D Image Segmentation 
and labeling tools in GeoDict. 

 

 

 

When clicking on the names of the 
features, the user is forwarded directly 

to the according method in the 
Segmentation & Labeling tab to the 

left of the 3D Image Processing 
dialog. 
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VIEW OPTIONS 

The View Options section offers a quick access to the most used visualization 
settings and is therefore always displayed.  

Among other options, set the Gray Value Range to be viewed, choose between the 
two View Modes (see View menu described on page 25), or Zoom in and out by a 

factor 2 per click. 

 

◼ Adjusting the Gray Value Range narrows or widens the interval, within which 

the gray values brighten from black to white. You may move the slider or directly 
enter specific numbers to change the interval. For more details, see page 29. 

◼ From the Overlay pull-down menu select the desired processing visualization. For 
more details, see page 31.  

◼ The Visibility slider increases or decreases the color-coded visibility of the current 
segmentation thresholds. See page 32 for more details. 

◼ Outline changes the representation of the thresholds from coloring full materials 

to coloring the interfaces between the currently set thresholds. Refer to page 32 
for more details. 

◼ When Auto Collapse Tree is checked, the user only sees in the Image Processing 
and Segmentation section (left of the dialog), the image processing feature 
currently chosen from the respective tab. Other tree paths are collapsed 

automatically. 

◼ The View Mode options Tile View and Stacked View change the visualization 

area from showing 2D slices of all three directions and the histogram section to 
showing only one of the directions or one of the tabs of the histogram section. 
Refer to the View menu on page 25 for more details. 

◼ The Zoom buttons at the right of this view section zoom in and out of the 2D 
slices by a factor of 2. Note that continuous zooming is possible by right-clicking 

into the image, holding the mouse button, and moving forward and backward. 

◼ Raise the GeoDict Main Window by clicking on the corresponding icon , to 
spare time searching for this window in the taskbar. 

 

GRAY VALUE RANGE 

Adjusting the Gray Value Range narrows or widens the interval, within which the 

gray values brighten from black to white.  

 

Move the slider or directly enter specific numbers to change the interval. 

In the following images, observe the difference with varying settings. 
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By setting the gray value range from 0 to 255, 

the gray values are shown for the full data range. 

 

 

 

 

 

 

 

 

 

When the gray value range is selected from 100 
to 255, the gray values between 0 and 100 are 
assigned the color black, while the rest becomes 

relatively darker. 

 

 

 

 

 

 

 

The higher range of gray values is taken out of 
the image when setting the gray values range 

from 0 to 100. The voxels with gray values from 
0 to 100 become relatively brighter, whereas 

those with values 101 and higher are assigned 
the color white. 
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OVERLAY 

From the Overlay pull-down menu select desired overlay for the 2D Slice Visualization 
section. The selection is also fitted automatically, if the 

corresponding options in the Image Processing and 
Segmentation section are edited. 

The available overlays are None, Crop, Rotate, Shear, Ring 

Removal, Slice Alignment, Segmentation, AI-Labels, AI-
Preview and AI-Mixed.  

If None is chosen, there is no overlay displayed in the 2D Slice 
Visualization section. 

The first five options after None correspond to the Image the 
Processing tab and the last four visualize options available in 
the Segmentation & Labeling tab. 

Image Processing overlays 

The option Crop corresponds to the feature Image Size – Crop. If selected, a yellow 

rectangle displays the cutout resulting from the entered values. Examples are given 
on page 40. 

The option Rotate corresponds to the feature Image Alignment – Rotation and 
displays the resulting new axes, if the visualization of the axes is turned, as described 
on page 26. 

The overlay Shear corresponds to the option Image Alignment – Shear, as 
described on page 49. 

If Ring Removal is selected, a yellow ring is displayed on the images, visualizing the 
values entered for the option CT Filters – Ring-Artifact Removal. For further 
description see page 78. 

The overlay Slice Alignment corresponds to the feature FIB-Sem Filters – Slice 
Alignment (Z-Direction) described on page 73. If selected, a red rectangle in the 

X-Y-plane displays the cutout resulting from the entered values. 

Segmentation & Labeling overlays 

The overlay Segmentation is selected by default and shows the resulting 
segmentation if the Visibility is turned on, as described in the next chapter. The 
visualized segmentation corresponds to the values entered for the options in the 

Image Segmentation section described on page 80ff.  

The overlays AI-Labels, AI-Preview and AI-Mixed correspond to the AI-based 

Segmentation method described on pages 86ff.  

  



ImportGeo submodules – ImportGeo-Vol 

32  GeoDict 2023 User Guide 

VISIBILITY AND OUTLINE 

The slider for Visibility and the checkbox for Outline control the visualization of the 
threshold(s) used for segmentation. By moving the Visibility slider, the appearance 

of the threshold(s) is changed in the 2D Slice Visualization section. 

 

When checking Outline, only the interface between segmented phases is overlaid 
with the given thresholding color(s). 

In the following images, observe the difference with varying settings. 

 

 

 

 

Here, the thresholded image is not visible and only 

the image gray values are shown. 

 

 

 

 

 

 

 

With intermediate Visibility, an overlay of the 
thresholded image and the gray value image is 

shown. 

 

 

 

 

 

 

 

With Visibility at its maximum, only the 

thresholded image is shown. 
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With Outline checked and intermediate Visibility, 
the interface between segmented phases is slightly 

overlaid with the given thresholding color. 

 

 

 

 

 

 

 

With Outline checked and increasing Visibility, 
these interfaces become increasingly highlighted. 
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2D SLICE VISUALIZATION 

In the default Tile View, the 2D Slice Visualization section contains the preview 
areas for the X-Y plane, the Y-Z plane, and the X-Z plane.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Below the 2D images, the values in Z-Slice, X-Slice, and Y-Slice control which slices 
are shown above in the preview areas. These values can be quickly changed by resting 
the mouse cursor on the field box and using the mouse wheel. The slice that is being 

shown also moves in the three-dimensional representation in the 3D Preview tab in 
the Histogram section. 

Zoom in and out either by using the corresponding buttons in the View Options 
section or click and hold CTRL and scroll the mouse wheel while resting the cursor on 
a gray value image slice. For continuous zooming, right-click into the 2D image, hold 

the mouse button, and move the mouse forward and backward to zoom in and out.  

Pan the image by left-clicking. 

For more information about 2D visualization, please also refer to View menu 
described on page 25 and the View Options section on page 29.  

As the gray value image is also loaded to the GeoDict visualization area, also consider 

the possibility of advanced 3D visualization described in the Visualization handbook 
of this User Guide. 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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HISTOGRAM 

The Histogram section contains statistical information on the gray value image in 
several tabs.  

 

The Histogram shows the frequency of all gray values as absolute numbers 
potentially providing information on the number of distinguishable material phases. 

The 3D Preview shows the currently selected X-, Y-, and Z-slices in a 3D 
representation. For more details see page 37.  

In the Gray Values X, Y, Z tabs, the slice mean of the gray values is plotted including 

a quadratic fit. 

In the AI Label Data tab find a plot corresponding to the labels of the AI 

Segmentation. 

HISTOGRAM 

The appearance of the histogram, on the bottom right, is controlled through the 

options right next to it and by the context menu accessible by right-clicking in the 
plot. The histogram plots the number of voxels against the gray values (in the given 

gray values range) and shows how many voxels have a particular gray value. 

 

 

 

The ranges for Gray Value and Voxel Count control the horizontal and vertical axes 

of the histogram. To focus on a region of the plot, change the range of values for 
voxel count and gray value. Interactively, the histogram changes and shows the 

portion of the plot corresponding to the new range of values. Moving the sliders allows 
a sort of zooming in and out of the plot in order to focus on a range of values. 
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The Plot Style can be changed from the default 

Bars to a Line plot depending on the favorite 
visualization. 

 

 

 

 

 

 

Logarithmic Scaling of the Y-Axis may be 
deactivated to highlight the gray value ranges 

of material phases. 

 

 

 

 

 

 

For another form of the histogram plot, choose 
to not Show Threshold Visualization. 

 

 

 

 

 

 

 

Right-click into the plot to further change the 

appearance, save the image (.png or .svg), 
copy the image to the clipboard or store all 
graph values in a .txt file. The context menu is 

the same as for the Result Viewer plots, and 
therefore is described in the Result Viewer 

handbook of this User Guide. 

 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
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3D PREVIEW 

The 3D Preview displays the 2D slices that are currently chosen in the 2D Slice 
Visualization. 

A 3D representation of these slices is visualized and updates interactively when 
changing the current slice selection. 

For full 3D visualization options, please refer to the Visualization handbook of this 

User Guide. 

 

 

 

 

 

 

 

 

 

 

 

 

GRAY VALUES X, Y, Z 

For each of X-, Y-, and Z-axis, the gray value distribution is plotted in 1D as Slice 
mean.  

Additionally, a Quadratic Fit is calculated and plotted. 

These graphs may indicate brightness gradients in the scans. The Gradient 
Brightness Correction and Gaussian Brightness Correction filters handle these 

brightness artifacts as described on pages 56 and 58, respectively. 

 

 

 

 

 

 

 

 

 

 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023


ImportGeo submodules – ImportGeo-Vol 

38  GeoDict 2023 User Guide 

AI LABEL DATA 

In the AI Label Data tab find a plot corresponding to the labels of the AI 
Segmentation described starting on page 86. 

 

If no labels are given, the AI Label Data tab is not shown. If voxels are labeled in 

the AI Segmentation section, the plot shows, how much training data there is for 
all material Classes. This helps to evaluate if the Count of labeled voxels is similar 
enough for all materials, and thus enabling the user to improve the labeling.  

In the example above, much more voxels are labeled red (solid material) than are 
labeled white (pore space). Probably, the results of the AI Segmentation then will 

not be as good, as if they were equally labeled. 
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WORKFLOW MANAGER 

Check Show Workflow Manager to display the Workflow Manager, on the top left 
side of the 3D Image Processing dialog. This section displays either the Current 

Workflow or a chosen predefined workflow. The current workflow contains all image 
adjustments and filters that were applied (e.g., Ring Artifact Removal Filter).  

 

 

 

 

 

 

 

If a new workflow was added to the workflow folder during the current GeoDict session 

either by moving a GeoPy (GeoDict Python) file to the GeoDict settings folder or by 
using the Save Checked button, click Refresh to display the new workflow in the 

pull-down menu. 

Clicking Browse and add the selected GeoPy macro to the pull-down menu. 

The workflow buttons offer the possibility to run the entire workflow again (Run all 

Checked) or run only single steps (Step Next Checked). Features can be deleted 
(Delete Checked) or saved (Save Checked) to a new predefined workflow.  

Predefined workflows contain a set of image processing tools. The GeoDict settings 
folder already offers two predefined workflows: 

 

◼ The FIB-SEM Workflow (shown here) uses Flickering Correction (page 55), 
Slice Alignment (page 73), Curtaining Filter (page 77), Scale of image (page 

44), and the Non-Local Means Filter (page 61). 

◼ The Micro-CT Workflow combines Gradient Brightness Correction (page 

56), Enhance Contrast (page 54), and Non-Local Means Filter (page 61). 

Predefined workflows may be controlled by variables, but they can be edited (Edit 
Parameters) to adjust a workflow to the user’s needs.  

With Edit Macro, the chosen workflow script is opened for editing. To learn more 
about GeoPy macros refer to the Automation by scripting handbook of this User Guide. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2023
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IMAGE PROCESSING TOOLS 

The image processing tools are located in the Image processing tab in the Image 
Processing and Segmentation section of the 3D Image Processing dialog, 

directly below the Workflow Manager section. The tools are organized in trees to 
be expanded and collapsed. 

 

IMAGE SIZE 

The Image Size tree contains the panels Crop, Embed, Change Voxel Length, 

Change Slice Thickness, Scale, and Downsample, to control the image size and 
the resolution.  

 

 

 

 

 

 

CROP 

By selecting dimensional parameters in the Crop panel, a piece that the user wants 
to import as 3D model can be cut out. Starting at the left positions of the sliders (NX, 

NY, NZ: numbers of voxels in X-, Y-, and Z-direction) a box is cut out to the right 
positions of the sliders.  

 

 

When the sliders are moved, the 

new positions of the sliders define 
a region that appears highlighted in 

the 2D preview areas of the three 
directions as yellow lines forming a 
rectangle. Here illustrated for a 3D 

gray value image of a Berea 
sandstone: 
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The values for NX, NY, and NZ indicate the size the domain will have after clicking 

Crop 3D Image. Here it is 70 x 70 x 80 voxels. The cropped box appears in the 2D 
preview areas. 

 

 

 

If Automatic Crop is checked, the entered cropping parameters are ignored when 
clicking Apply. Instead, all pure-background regions around the structure are 

cropped, according to the current threshold. 

If Automatic Threshold is enabled, the Otsu method is used to threshold the image. 

Otherwise enter a Manual Threshold. Be aware, that this threshold is not used to 
segment the image, it is only used to decide where the image should get cropped.   

Clicking Suggest preloads the sliders with values such that all pure-background 

regions are cropped away, according to the current threshold. 

Clicking Apply crops the structure with the current settings. 
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EMBED 

Embedding adds empty voxels (voxels with a gray value of 0) around the current 

structure. Enter the amount as desired for the directions X-, Y-, Z-, X+, Y+, and Z+. 
Then click Apply to embed the image.  

This can be useful, for example to generate enough space to rotate the image without 
losing information. 

 

 

 

 

 

The embedding effect can easily be 
observed in the 3D Preview (shown 
here). 

 

 

 

 

 

 

 

 

 

 

CHANGE VOXEL LENGTH 

Change the resolution by changing the voxel length. If entering higher values for 
voxel length, the number of voxels in the three direction decreases, since less voxels 

are needed to build the image. 
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Select the unit for the voxel length from the pull-down menu at the top. The available 

units are m, mm, µm and nm. 

For Scale Function two methods are available. They are the same as for the Scale 

functionality described on page 44.  

Enter the desired New Voxel Length in the given unit. 

Click Apply to scale the image according to the new voxel length. 

 

 

 

 

 

 

 

 

 

 

 

 

 

CHANGE SLICE THICKNESS 

If the slices of a scan have a different thickness than the pixel size, it must be 

adjusted.  

 

 

 

 

 

 

 

Select the unit for the voxel length from the pull-down menu at the top. The available 
units are m, mm, µm and nm. 

For Scale Function two methods are available. They are the same as for the Scale 
functionality described on page 44.  

Select the Direction in which the slice thickness should be changed from the pull-

down menu. 

Enter the Slice Thickness in the given unit. 

After clicking Apply the selected scale function is applied to add or remove voxels in 
the given direction to come up for the different slice thickness. 
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SCALE 

In the Scale panel, for the Scale function, the user can choose between Tri-linear 
interpolation and Nearest Neighbor interpolation. Both are methods of multivariate 

interpolation in one or more dimensions. 

 

 

 

 

 

 

 

 

Boxels Lengths refer to the current lengths in the structure model, in the three 
directions. These values are automatically entered from the Voxel Length defined 
by the user at the bottom of the Geometry Import dialog.  

For FIB-SEM scans, for example, the length in Z-direction usually differs from the 
other two and corresponds to the spacing between images. This spacing is defined at 

the time of taking the stack of FIB-SEM images and should be included as data with 
the image files. Importing the stack directly, without accounting for the spacing 
distortion, results in a stacked structure, which does not replicate the original scanned 

one.  

 

To account for this spacing distortion, the length in Z-direction is entered and Apply 
is clicked. GeoDict scales only the voxels in that direction and completes the missing 
slices to make a uniform object. The size of the scaled object shown as NX, NY, and 

NZ in the Crop panel changes accordingly to reflect the fill-in.  

https://en.wikipedia.org/wiki/Trilinear_interpolation
https://en.wikipedia.org/wiki/Nearest-neighbor_interpolation
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The Re-sampled Length value is used to re-sample the physical structure size (voxel 

length) uniformly in all directions with a grid adapted to the re-sampled length value 
and, thus, coarsen or refine the imported structure.  

 

In the following example observe the difference between the two options for Scale 

Function. While the resulting number of voxels is the same for both options, Tri-
Linear additionally interpolates gray-values for a smoother transition. 

 

 

 

DOWNSAMPLE 

Downsampling is the process of combining multiple voxels to one in order to reduce 
the structure size. The user chooses to apply the Sampling Factor to the Voxel 
Mean Value or the Voxel Median in the Sampling Mode pull-down menu. 

Clicking Apply samples the structure with the current parameters. 
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IMAGE ALIGNMENT 

The Image Alignment tree contains the panels affecting the orientation of a 3D 
image: Rotation, Shear, Straighten, and Permute. 

 

 

ROTATION 

The three-dimensional rotation of the image is defined in the Rotation panel. Values 

for the Phi, Theta, and Psi Euler rotation angles or an angle to simply turn about 
one axis are entered and the image is rotated by clicking Apply.  

This feature is particularly useful when 
the images are not aligned to the 

inherent axis of the structure and empty 
space is found around the images.  

 

 

For Rotation Mode select Euler 

Angles, Rotate around X, Y, or Z 
Axis. 

 

The Euler rotation angles are applied 

following the order Phi → Theta → Psi. 

http://en.wikipedia.org/wiki/Euler_angles
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For Rotate around X, Y, or Z Axis enter the angle for the rotation about X, Y or Z. 

 

 

 

 

Enlarge Image Automatically can be checked to avoid having to crop the image 
after the rotation. 

If Automatic Rotation is checked, the entered parameters for the rotation angles 
are ignored when clicking Apply. Instead, the Euler rotation angles are calculated 

automatically based on principal component analysis for the imported gray value 
image. From the pull-down menu for Rotation Mode select Volume or Plane. 

For Volume the algorithm tries to align the structure to all three coordinate axes. 

For Plane only two major axes are aligned. Aligning only to two major axes can 
minimize unwanted rotations inside a planar structure.  

To suggest a rotation, the current threshold settings are used. If Automatic 
Threshold is enabled, the Otsu method is used to threshold the image. Otherwise 
enter a Manual Threshold. 

Values for the Euler rotation angles can also first be suggested by clicking Suggest - 
Volume or Suggest – Plane. These options enter the suggested parameters for Phi, 

Theta and Psi.  

Clicking Apply rotates the structure with the current settings. 

For example, here, a structure model is obtained first without rotation. Then, to obtain 
a structure that has been rotated only about the Y-axis by 90 or by 180 degrees, the 
following Euler Angles are used:  
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Of course, these two rotations can be obtained much easier, when selecting Rotate 

around Y-Axis for Rotation Mode, but the example helps to understand the Euler 
Angles. As they can rotate the 3D image in each desired direction, they are more 

powerful if the image should not only be rotated about one axis.  

 

If Rotate is selected for Overlay, the resulting rotation is visualized in the 2D Slice 
Visualization area. The diagonal red, green, and blue lines show the resulting center 
line. In the following example, the image is rotated about the X-axis. Therefore, in 

90 around Z-axis (fixed) +90 around new X-axis (fixed) + -90 around new Z-axis (fixed) 

90 around Z-axis (fixed) + 180 around new X-axis (fixed) + -90 around new Z-axis 

(fixed) 
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the YZ-plane a blue and a green diagonal can be observed. After rotating, these are 

the new center lines. 

 

 

 

ROTATE 90° 

The Rotate 90° option allows to simply turn the image by 90°. For more complex 
rotation options use the Rotation option described above. 

Select if the image should be rotated ClockWise or AntiClockWise around the 

selected Rotation Axis. 

 

Click Apply to rotate the structure as defined. 

SHEAR 

The Shear option allows to correct sheared volumes, occurring for example in FIB-

SEM images.  

 

For Shear Axis choose the shear direction and the coordinate that the Shear Angle 
is based on.  



ImportGeo submodules – ImportGeo-Vol 

50  GeoDict 2023 User Guide 

Clicking Apply shears the structure with the current settings. 

By Shearing the image, each voxel in shear direction (defined via Shear Axis) is 
displaced upon consideration of the Shear Angle.  

The figure below schematically describes the handling of a sheared image. Here, the 
image is sheared in X-direction resulting in a parallelogram.  

◼ To correct the image (into a rectangle), this direction must be defined in Shear 
Axis as “Shear in X-Direction based on Y-Coordinate”. 

◼ Then, the Shear Angle must be determined. Upon entering an angle, a yellow 

line appears in the according 2D slice, which will be the new “center line” after 
clicking Apply. 

Gray values are moved as indicated by the arrow lengths below. To learn more about 
the applied method refer to shear mapping on Wikipedia. 

 

 

In the following example, the gray value image needs to be sheared in Z-direction 
based on Y-coordinate. The Shear Angle is set to 5°. As Shear is selected for 

Overlay the resulting center line is visualized with a yellow line. 

 

 

 

 

 

https://en.wikipedia.org/wiki/Shear_mapping
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STRAIGHTEN 

The images of structures captured in a µCT scanner may have a slight bow or warp 

to them. The process of straightening is especially interesting in case of flat 
geometries and can be used to make the structure model in the image lie flat again. 

For this, a surface with a given Surface Degree is fitted through the structure and 
aligned to a Sheet Plane.  

 

Select the sheet plane to be in X-Y, X-Z, or Y-Z direction or let the direction be 
estimated Automatically. 

If Automatic Threshold is checked the structure resulting from the Otsu threshold 
is straightened. Otherwise enter a Manual Threshold.  

Clicking Apply straightens the structure with the current settings. 

 

Example: Here, the bow of a grain structure is 

removed by applying the straightening process.  

The bow can be observed in the 2D Slice 

Visualization section. On the right the first and 
the last X-slice are shown. Observe the bow in both 
slices. Also, the bow can be observed in X-

direction, by comparing the two slices. 

 

Applying Straighten with default settings leads to 
a straightened structure, shown on the right in 2D 
and below in 3D. 

 

  

Original 

Straightened 

Original, first X-slice 

Original, last X-slice 

Straightened, first X-slice 

Straightened, last X-slice 
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MIRROR 

Mirror the image along the plane orthogonal to the selected Mirror Direction axis 

by clicking Apply.  

 

In the example below, Z is selected as Mirror Direction. Thus, the image is mirrored 

along the XY-plane. 

 

PERMUTE 

Permute changes the allocation of the axes for the structure to be imported. Select 
the desired permutation of axes and click Apply. For example, if the structure’s X-

axis should be exchanged with the Z-axis, the user selects X ↔ Z, and clicks Apply. 

Now what used to be the X-direction has turned into Z-direction.  
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GRAY VALUE (BRIGHTNESS) ADJUSTMENTS 

The Gray Value (Brightness) Adjustments tree contains the tools Sample to 8 / 
16 bit, Enhance Contrast, Flickering Correction, Gradient Brightness 

Correction, Gaussian Brightness Correction and Invert Image. They are used 
for gray value adjustments related to the brightness of the image.  

 

 

 

SAMPLE TO 8 / 16 BIT 

The image can be sampled to 8-bit or 16-bit format through the Sample to 8 /  
16 bit panel. Each pixel in the image is then represented by an 8-bit or 16-bit value, 

respectively. 

The current image format is shown in the panel. Here, the Image has 16-bit gray 
values. So, each pixel contains a gray value between 0-65535, which is basically 216 

different values.  

 

 

 

Enter the Minimal Gray Value and the Maximal Gray Value for the image going to 
be sampled. These values adjust the gray value range for the 8-bit or 16-bit image. 

Select 8 Bits or 16 Bits from the pull-down menu for Sample to Range. 

Converting 16-bit to 8-bit format is often done to reduce the large data size of 16-bit 

images. The gray value range reduces to 0-255 by choosing 8 Bits. 

If 16 Bits is selected, the bit depths can be increased from 8-bit to 16-bit.  

Clicking Apply samples the image with the current settings. 

The following images show an example for changing the gray value range in an 8-bit 
image of a Berea sandstone. Here, the contrast between solid phases (mid and bright 

gray values) and pore space (dark gray values) increases by reducing the original 
gray value range to 70-200 instead of 0-255. 
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ENHANCE CONTRAST 

The Enhance Contrast feature offers the possibility to increase the contrast in the 

3D image data. When applying Enhance Contrast, keep observing the changes in 
the histogram.  

 

 

 

 

 

 

 

The usage of Saturated Bright Voxels and Saturated Dark Voxels changes the 
gray value distribution in the image. With 0% each, the gray values are automatically 
distributed to the entire gray value range, this is also possible in Sample to 8 /  

16 bit with manual settings as described on page 53. Increasing the percentages 
narrows the considered gray value range by ignoring the given percent of bright 

and/or dark gray values, respectively. Thus, higher values will increase the contrast. 
In detail, the given percentages of bright and dark gray values are set to 0 and the 
last gray value, respectively and the intermediate gray values are equally distributed 

over the complete possible gray value range. 

When checking the option Equalize Histogram, this feature equalizes the gray 

values in the histogram. The original distribution of gray values is then balanced, so 
that each gray value contains an equal number of occurrences in average. This 
especially pulls the most frequent gray values apart to reach the highest contrast 

possible. 

Clicking Apply enhances the contrast in the image with the current settings. 
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The examples below show histogram results for the different settings. Note the high 

voxel count at the maximum gray value 255, which strongly affects the gray value 
distribution after application of Enhance Contrast.  

The gray values are separated and distributed to use the complete gray value range. 
Through the resulting gaps between the gray values the contrast is improved.  

 

FLICKERING CORRECTION 

When sliding through the image in one direction, some scans show a “flickering” in 
the display of the 2D slices. This is common in FIB-SEM scans and these images 
require a Flickering Correction. 

 

 

First choose the Direction, along which the flickering occurs: X, Y or Z. 

The Correction Method provides the two options Multiplicative and Additive both 
depending on the processing applied by the image acquisition device. The information 
about whether the acquisition device uses linear or logarithmic image processing is 

usually provided with the scan image data. 

Original 
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◼ If the processing is linear, use Multiplicative correction method. 

◼ If the processing is logarithmic, use Additive correction method. 

Clicking Apply applies the Flickering Correction according to the given settings. 

GRADIENT BRIGHTNESS CORRECTION 

The Gradient Brightness Correction is required when the user observes a slow 
brightening / darkening when sliding through the image in one direction. 

 

First choose the Direction, along which the gradient occurs: X, Y or Z. 

The Correction Method provides two options, both depending on the applied image 

acquisition device. If the acquisition device is linear, use Multiplicative correction 
method. If the acquisition device is logarithmic, use Additive correction method. 

With Enabled ROI the gray value range can be restricted within which the correction 
is applied. The according minimum and maximum gray value of that range are chosen 
at Histogram ROI. 

Clicking Apply applies the Gradient Brightness Correction according to the given 
settings. 

The following example shows a brightness gradient from exterior to interior in a Z-
axis slice. That gradient can also be observed in the Slice Mean gray value (see the 
Histogram section on page 35), shown in the following diagrams for the X-axis.  
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The Gradient Brightness Correction is applied for Direction Z without Enabled 
ROI. The correction improves the gray value image significantly. As a result, the gray 

value histogram now shows a strongly improved differentiation between pore space 
and solid phases. The slice mean gray values now have a linear trend along the X-

axis: 

Original 
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GAUSSIAN BRIGHTNESS CORRECTION 

The aim of the Gaussian Brightness Correction is to balance bright/dark regions 

in the image. 

 

 

 

 

 

 

 

The Sphere Radius controls the size of the region, in which the correction is applied. 
The Gaussian Brightness Correction works for all types of brightness variations if 

the grain diameters (𝑑𝑔𝑟𝑎𝑖𝑛𝑠) are small in relation to the Sphere Radius (𝑟𝑠𝑝ℎ𝑒𝑟𝑒): 

3 × 𝑑𝑔𝑟𝑎𝑖𝑛𝑠 < 𝑟𝑠𝑝ℎ𝑒𝑟𝑒 

The Correction Method provides two options both depending on the applied image 
acquisition device. If the acquisition device is linear, use Multiplicative correction 

method. If the acquisition device is logarithmic, use Additive correction method. 

Clicking Apply applies the Gaussian Brightness Correction according to the given 

settings. 

Corrected 
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INVERT IMAGE 

The Invert Image option inverts the gray values, when clicking Apply.  

 

 

 

IMAGE FILTERS 

The Image Filters tree contains the panels Non-Local Means Filter, Median 
Filter, Mean Filter, and Gauss Filter, as well as Sharpen Filter, Morphological 

Filter, H-Minima Transform, Compute Gradient, Watershed (Supervoxel) and 
User Defined Filter. 

 

 

 

 

 

 

 

 

 

 

Clicking Preview for any of the filters (when this button is available) opens a dialog 
(Parameter Gallery for … Filter) showing the effect of the entered filter parameters 

on the image.  

The left of the dialog allows settings for Gray Value Range (see page 29), Threshold 
Visibility (see page 32), Threshold, and some viewing parameters such as the View 

Direction, the Zoom Factor, and the x Slice, y Range, and z Range, which define 
the size of the preview sub-region and the visible plane. 

Clicking Create / Update Preview renders a set of images that can be used to 
identify the wanted filter effect. 

Depending on the filter, different preview parameters can be set.  
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For the Median Filter, the Mean Filter, and the Morphological Filter, a range of 

Radii (here 1 to 3 voxels) can be chosen. 

 

 

 

 

 

 

For the Gauss Filter, Sharpen Filter, and the Non-Local Means Filter, one of the 

parameters can be chosen to be a Varying Parameter, while a fixed value is entered 
for the other parameters.  

For example, here, for the Non-Local Means Filter, the Patch Radius is set to be 
the Varying Parameter whereas the Window Radius, the Strength, and Prefilter 
have fixed values. 
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Select the best parameter combination on the right by simply clicking on the desired 
image. After closing the dialog, these parameters are entered for the corresponding 

filter.  

NON-LOCAL MEANS FILTER 

Clicking Apply, applies a Non-Local Means Filtering to the 3D image. This is a very 

powerful filter to reduce noise while still keeping edges sharp. To learn more about 
the underlying theory see e.g., Wikipedia. 

 

 

The size of edges is controlled with Patch Radius determining the size of regions 

compared and Search Window Radius. The latter determines the neighborhood 
around each voxel, for which regions are compared. The amount of smoothing is 
controlled with Filter Strength. For very noisy images it can be necessary to Enable 

Prefilter. By applying a Gaussian filter, noise is reduced before applying the NLM-
filter. This option improves the patch comparison in this case. 

 

https://en.wikipedia.org/wiki/Non-local_means
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The left image shows the original gray values of an image. The right image shows the 

same image after applying the Non-Local Means Filter with default settings. 

 

 

 

 

 

 

 

 

 

 

 

Image enhancement filters can be very time-consuming when being applied to 
complete 3D image data. Specially the Non-Local Means Filter can significantly 

improve the quality of segmentations, but applying it takes longer than other filters. 
For this reason, an option to preview the effect of the filter parameters before applying 
them has been added to the most filters under the Image Filters tree. 

MEDIAN FILTER, MEAN FILTER, AND GAUSS FILTER 

The Median filter , the Mean filter and/or Gauss filter can be applied to the 3D image 
to remove noise that has the specified Sphere Radius, or to smooth the image. 

The given sphere radius defines the size of the 
mask used for the filtering of the 3D image. By 
entering the sphere radius in voxels, and clicking 

Apply, the image is immediately filtered.  

 

 

 

 

 

 

 

 

 

 

Observe the cleansing effect of applying the median filter after setting the sphere 

radius in the original structure to 1 and then 3 voxels. Similar results are obtained 
applying the Mean Filter or the Gauss Filter with the same sphere radius values. 
Please consider that the ProcessGeo module already contains a Cleanse possibility 

for the segmented image. 

 

http://en.wikipedia.org/wiki/Median_filter
http://en.wikipedia.org/wiki/Background_subtraction#Mean_filter
http://en.wikipedia.org/wiki/Gaussian_filter
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The first row shows the filtered gray values images. The second and third rows 

correspond to 2D and 3D Rendering views of the structure model imported after each 
processing. 

 

For the Gauss Filter, the Sigma value in voxels corresponds to the standard 
deviation of the Gaussian filter. 

SHARPEN FILTER 

Clicking Apply, a Sharpen filter is applied to improve low contrast 3D images. The 

amount of sharpening is controlled with the Strength parameter.  

 

 

 

 

 

 

Radius determines the area around edges that will be sharpened.  

Threshold / (Gray Value) restricts the sharpening to regions with a minimal 
difference in gray values. This allows keeping more homogenous regions from getting 

noisy. 

MORPHOLOGICAL FILTER 

The Morphological Filter contains several different Operations. 

Each Operation requires the input of a Sphere Radius, controlling the size of the 
region, in which the filter is applied. Clicking Apply applies the chosen filter. 

https://en.wikipedia.org/wiki/Unsharp_masking
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Some of the Operations are illustrated with an example based on an artificial gray 
value image consisting of few grains at high porosity. The 2D slice images show a 
multiple threshold segmentation preview as described on pages 84ff. 

 

◼ Opening: Removes bright structures smaller than the given spheres. Please note, 
the Cleanse tool of the ProcessGeo module removes these so-called “Island 

artifacts” from segmented structures. 

◼ Closing: Removes dark structures smaller than the given spheres. Please note, 
the Cleanse tool of the ProcessGeo module removes these so-called “Island 
artifacts” from segmented structures. 

◼ TopHat: Removes bright regions larger than the given sphere. 

◼ BottomHat: Removes dark regions larger than the given sphere. 

◼ Dilation: Grows bright regions in the image. Assigns the brightest gray value to 
spheres with the given radius, in the entire image. 

◼ Erosion: Grows dark regions in the image. Assigns the darkest gray value to 

spheres with the given radius, in the entire image. 

 

 

 

 

 

 

 

 

◼ Gradient: Both Erosion and Dilation are applied to the image. Then, the erosion 
image is subtracted from the dilation image to mark gradients and borders. 

Original Opening Dilation 

Erosion 
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H-MINIMA TRANSFORM 

The H-Minima-Transform was invented to reduce the over-segmentation of the 

watershed algorithm, by reducing noise in the darker regions of the gray value image.  

 

The method searches for local minima in the gray value image and suppresses them, 
if their depth is lower or equal than the Minimum Height. The depth of a local 

minimum is defined as the difference between the gray value in the local minimum 
and the next local gray value maximum.  

In the simplified 2D example below, the neighboring gray values are shown in gray 

bars. For each local minimum the corresponding depth is visualized in blue.  

For comparison, the given Minimum Height is visualized as a red rectangle. Observe 

that the depth of the two minima in the center is lower than the Minimum Height, 
while the other two have a depth higher than the Minimum Height. Thus, the two 
in the middle will get suppressed and the other two will not, as shown below.  
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The Tolerance is the relative change in the image mean gray value. If 0 is entered 

for Tolerance the runtime can be very long, trying to find a perfectly stable solution. 
In most cases, however, a slightly higher tolerance, for example the default of 0.001, 

already leads to good results. 

Click Apply to apply the filter on the gray value image. 

In the following the example was already filtered with the Non-Local Means Filter 
(see page 61) and a Morphological Gradient (see page 64). Then, the H-Minima 
Transform is applied with a Minimum Height of 30. 

 

 

COMPUTE GRADIENT 

The option Compute Gradient computes the gradient for each voxel in the gray 
value image, when clicking Apply. This results in an image where the gray values are 

brighter towards the borders.  
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WATERSHED (SUPERVOXEL) 

The watershed transformation treats the image it operates upon like a topographic 

map, with the brightness of each point representing its height, and finds the lines that 
run along the tops of ridges.  

The Watershed (Supervoxel) is based on the Euclidean Distance Transform 
(EDT). Watershed component seeds are placed in the local maxima of the EDT, and 
in those seeds, components start to “grow”. In the growing process, component 

boundaries are formed as soon as components touch. 

 

 

The implemented algorithm detects edges based on the gray value gradient or 
morphological gradient (see Preprocessing on page 68) in the imported 3D image. 
Subsequently, a distance map is created depending on the edge distances. Maxima 

in the distance map (see image below) are used as seeds for the watershed algorithm, 
which is performed on the distance map. 

 

The concept behind the watershed can be understood more easily in a 2D example. 
In this representation, the EDT can be regarded as a topographical relief where high 

values represent valleys and low values represent peaks. This topography is 
continuously “flooded with water”, starting from the deepest valleys.  

As soon as the water from neighboring valley begins to mix, a dam is created 
(corresponding to the grain boundary). The result is a topography with water-filled 
valleys and dams that separate them. The identified valleys represent the watershed 

components and the dams that separate them denote the component boundaries. 

In the figure below, the progression of the watershed algorithm is illustrated. On the 

left side, the topographical relief corresponding to the EDT is shown where the 

Distance map in solid space 

Original structure 

Distance map in pore space 

https://en.wikipedia.org/wiki/Watershed_(image_processing)
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component seeds (valley bottom) are marked in red. This topography is successively 

flooded with water, and dams are formed between adjacent valleys. 

Known information about the component space, i.e., the minimal component 

diameter, can be used to adjust the results of the Watershed (Supervoxel). 

Each watershed component is assigned the mean gray value of this component. This 

is the supervoxel. The result is a gray value image, that is much easier to segment. 

 

 

 

If the image has artifacts in the beginning it is recommended to use other image 

filters as for example the Non-Local Means Filter described on page 61 before 
running the Watershed (Supervoxel). Then the algorithm leads to better results. 

The name for the file and folder containing the results can be entered in the Result 
File Name (*.gdr) box. Choose a name fitting the current project. 

For Preprocessing three options are available in the pull-down menu: 

◼ Morphological Gradient: A morphological gradient is computed from the gray 
value image, as described on page 64. Then the watershed algorithm is applied 

to this gradient. 

◼ Gradient:A gradient is computed from the gray value image as desribed on  
page 66. Then, the watershed algorithm is applied on this gradient. 

◼ None (Gray Value Image): The watershed algorithm is applied to the gray value 
image directly. In most cases, this is not recommended. 

If Morphological Gradient is selected, a Gradient Radius must be specified. The 
radius controls the size of the region, in which the morphological filter is applied. 

For Seeding select how the seeds should be specified. 

◼ Minima Transform:The seeds are specified by a H-Minima Transform. 

◼ Index Image: A corresponding index image (*.g32) has to be loaded in GeoDict. 

Therefore, select File → Load Volume Field from the menu bar and browse for 

the corresponding *.g32. This file specifies the seeds. 

The Minima Transform is controlled by the parameters Minimum Height and 

Tolerance. Find a detailed description on page 65. 

The seeds found by the Minima Transform can be saved in a *.g32 file by checking 

Keep Seeds as Index Image.  
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Click Apply to run the watershed algorithm. 

In the following example, a Morphological Gradient with Gradient Radius 2 was 
applied and for the Minima Transform a Minimum Height of 15 was used. 

 

Observe the resulting difference in the Histogram making it possible to simply apply 
the automatic Otsu threshold. 

 

Otsu Threshold before Watershed 

Otsu Threshold after Watershed 
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Result 

The result file with the selected Result File Name is opened automatically in the 
Result Viewer. Under the Results – Report sub-tab the number of watershed 

components, the minimal, maximal, and mean size of the components can be found.  

 

Move to the Data Visualization tab to visualize the Index Image of Watershed 
Components in the GeoDict visualization area by clicking Load *.g32. If Keep 

Seeds was checked, the Watershed Seeds can also be visualized by clicking the 
lower Load *.g32 button. Otherwise, it is grayed out. 

 

 

 

In the opening dialog click OK and the index 

image is loaded in GeoDict. 

 

 

 

 

Find more information about GeoDict result files in the Result Viewer user guide. 

 

 

Watershed Componenents Watershed Seeds 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
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USER DEFINED FILTER 

Own scripts can be used as image filters for the user’s data. Examples for such user 

defined scripts can be found in the ImportGeo folder in the GeoDict installation folder 
and in the GeoDict settings folder.  

 

 

 

 

 

Therein, the script “PhansalkarFilter.py” can be used to learn how to obtain and 

change the image data that is shown in the ImportGeo-Vol box. Click Browse to 
navigate to the GeoPy macro. Click Edit Script to open the file in a text editor. In 

the macro use the command  

Im = gd.ImportGeoVol.getOriginalImage() 

to load the actual image with the Python script and  

img = gd.ImportGeoVol.getNewImage()  

to create a new image.  

The dimensions can subsequently be extracted with the “shape” command:  

nx=img.shape[0] 

ny=img.shape[1] 
nz=img.shape[2]  

With loops over each image voxel, the Phansalkar script determines, if the according 

voxel should be set to white [255] or black [0]. It is sufficient to change the new 
image (“img”). Please refer to the section Phansalkar and the Automation by 

scripting handbook of this User Guide for more details on this topic.  

For a parameter macro, the parameters can be edited by clicking Parameters. 

To run the macro click Apply. 

ENHANCE IMAGE (AI) 

Use the GeoDict module GeoDict-AI to train a neural network to transform a low 
quality image into a high quality image. For example, a scan can be taken from less 
angles or with reduced exposure time, if a network was trained to improve them. 

How to train a neural network to enhance gray value images is explained in the 
GeoDict-AI User Guide. 

If a suitable graphics card is detected during installation of GeoDict, the GPU mode 
is used for running Enhance Image (AI), otherwise it is running in CPU mode.  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoDictAI&release=2023
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Browse for the neural network model trained with GeoDict-AI and best suitable for 
the image under consideration.  

In the Description, the current constraints for the application of the neural network 
are listed, as entered in the GeoDict-AI module for training neural networks, e.g. the 
kind of images the neural network was trained for. 

The choice for Batch Size is related to the memory available on the graphics card 
(GPU). Conceptually, GeoDict loads the graphics card with portions of work called 

batches. Currently, the selection must be made manually, and the parameter is set 
following the value entered in Batch Size.  

The batch size might be chosen too large for what is available on the graphics card. 

In this case, an error message appears, and the enhancement is aborted.  

Clicking Apply starts the image enhancement. 
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FIB-SEM FILTERS 

The specialized FIB-SEM Filters section contains Slice Alignment (Z-Direction), 
Slice Thickness Adjustment and the Curtaining Filter. 

 

SLICE ALIGNMENT (Z-DIRECTION) 

During FIB-SEM image acquisition, the alignment of the image slices typically along 
the Z-axis is not maintained due to e.g., specimen drift or image distortions. 

Accordingly, a Slice Alignment is necessary.  

 

 

 

 

 

 

 

 

 

Please make sure that the image is oriented with the misalignments in Z-direction 
before starting to Align Slices. This is best observed by sliding through the 2D slices 

in Z-direction. Typically, offsets are visible when looking at images in X- and Y-
direction. If the misalignments occur in another direction, either rotate the image as 
described on page 46 or permute the image, as described on page 52. 

Two options are available for the Alignment Method.  

◼ If Correlation is selected, the algorithm tries to shift the slices in X- and Y-

direction till the regions are as similar as possible within the defined region of 
interest. 

◼ The SIFT (Scale-Invariant Feature Transform) can recognize features and 

tries to map the features to each other by shifting and rotating the slices. This 
works very well, if the features are very similar in the different slices. Find 

more detailed information on this method in the Wikipedia article. 

The choices for ROI First Slice and ROI Last Slice for X and Y define the region, 
in which the alignment is examined. Based on the findings for that region, the slice 

alignment is corrected for the entire image. Please note that this might lead to 
unavoidable boundary effects that might require a Crop at the image boundaries, as 

described on page 40. The rectangle resulting from the values for First Slice and 
Last Slice is visualized in yellow in the 2D Slice Visualization section in the X-Y-
plane if Slice Alignment is chosen for Overlay.  

 

https://en.wikipedia.org/wiki/Scale-invariant_feature_transform
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For the Correlation method, the Radius defines the maximum shift between two 

slices to search for. For many FIB-SEM images the default value of 10 is enough. 
However, if there are slices shifted more than 10 voxels the Radius setting needs 

to be increased. 

For SIFT the SIFT Threshold for the image features used can be defined as Low, 
Medium or High. With a higher threshold only more significant image features are 

used and with a lower threshold more image features are used. If the alignment does 
not modify the image, choose a lower threshold. If on the other hand, the alignment 

is not correct, a higher threshold can be better. If setting the threshold to Automatic 
the thresholds are adjusted automatically. 

The example on the right shows a 2D slice 

from X-direction of an artificially 
misaligned gray value image (top). After 

application of the Slice Alignment tool at 
suggested default settings (see above), 
the misalignment is entirely corrected 

(bottom). 

 

Observe the offsets on the left and right 
boundaries of the aligned image 
(bottom). Accordingly, the image size in 

X- and Y-direction increased in order to 
include all aligned slices in the 3D image 

without loss of information. 

  

X-Direction, Original 

X-Direction, Aligned 
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SLICE THICKNESS ADJUSTMENT 

In FIB-SEM images the slice thickness can be different for each slice. If the image 

provides information about the slice thickness, as is the case e.g., for images taken 
by Zeiss machines, the Slice Thickness Adjustment can be applied on the image. 
Otherwise, NO Slice Thickness Available is displayed in the top of the section. 

  

In the following figure observe how the different slice thicknesses are assigned to 

coordinates building a vector indicating slice thickness. 

 

These vector entries must be provided with the considered image stack. Therefore, 
each image of the stack must have the ending “_z=…um” (unit must be in given in 
microns), where “…” of course must be replaced by the corresponding coordinate, 

e.g., image_001_z=1.0um.tif, image_002_z=2.1um.tif, image_003_z=3.3um.tif, 
…. FIB-SEM image stacks from Zeiss machines follow this name-scheme. 

The slice thickness is adjusted by interpolating gray value images between the given 
Z-slices to fit the the given distance.  

If Use X/Y Voxel Length is checked, the distance between the resulting Z-slices is 
set equal to the voxel length in the X- and Y-direction. Otherwise enter the desired 
Z-Distance in nm. 

For the gray value Interpolation select between Linear and Nearest Neighbor. 

Clicking Apply applies the Slice Thickness Adjustment to the image. 

 

In the following example, the slice thickness between the single images is approx. 2 
µm, while the voxel length in X- and Y-direction is 1 µm.  

 

https://en.wikipedia.org/wiki/Nearest-neighbor_interpolation
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Thus, checking Use X/Y Voxel Length and clicking Apply leads to 256 slices 

instead of 129 and thus, the image is stretched in Z-direction. 
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CURTAINING FILTER 

The Curtaining Filter removes curtaining effects, which are typical for FIB-SEM 

image scans. In general, the filter applies a deconvolution to receive two 3D images, 
one only containing the stripes of the curtaining effect while the other image is the 
resulting filtered image. 

To learn more about this filter refer to  [2]. 

 

The filter includes three Stopping Criteria, and the corresponding values for 

Tolerance or Iterations, which control the computational time and the quality of 
the filter results. We recommend that the values for these convergence settings 
usually be left at default settings: 

◼ In the Iterations mode, the filter stops after a given number of Iterations. 

◼ With Change Dual, a tolerance value is determined internally. The filter stops 

iterating upon reaching the given tolerance. 

◼ In the Change Result mode, the differences in the gray values between the 

iterations are examined for defining the tolerance value. This mode requires 
approx. twice the amount of working memory. 

The given Tolerances do not depend on the image size. 

The Filter Strength can be increased, to remove heavy stripes, or decreased, to 
reduce the effect of the Curtaining Filter. 

Clicking Apply applies the Curtaining according to the given settings. 

The example below shows the lines that are typical for FIB-SEM gray value images 
(left) and known as Curtaining effect. After application of the Curtaining Filter, 

these lines are completely removed from the original image, enabling a proper image 
segmentation. 

  Before Filtered 
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CT FILTERS 

The specialized CT Filters section was introduced in GeoDict 2020 and currently 
contains the Ring-Artifact Removal filter. 

 

 

 

 

RING-ARTIFACT REMOVAL 

The Ring-Artifact Removal removes ring artifacts from CT scans. In order to work 
as expected, the Z-axis must be the rotation axis, which is the standard for CT scans. 

If that is not the case, however, the image can either be rotated as described on 
page 46 or permuted as described on page 52 before applying the Ring-Artifact 

Removal. 

The first step of the filter workflow is the definition of the midpoint of the rotation 
axis and the extent of the artifacts. Based on the midpoint, the filter looks for 

artifacts at every possible radius (see blue line in image below). At each of these 
radii, an extent is examined as given by the Window size (see red ring in image 

below). Within these extents, the effect of the Ring-Artifacts on the gray values is 
examined.  

However, the algorithm requires a correction wherever multiple phases are affected. 
Therefore, a Threshold value must be given in order to define a maximum gray 
value range. That value varies with different materials and scans. It must be smaller 

than the variance between the ring-artifacts and the average gray value inside a 
window around the ring artifact. 

Please note that there is a significant difference in gray values between e.g., 8-bit 
and 16-bit images.  

 

 

 

◼ Center X, Y: Find and insert the center of the Ring-Artifacts (i.e., rotation axis) 

◼ Window: Determine here the extent, within which Ring-Artifacts can be 
identified (see red ring below) 

◼ Threshold: Determine here the max. gray value range for the windows. This 
affects the correction that is applied as averaged gray value. 

◼ Radius: Determine and insert the maximum extent of the Ring-Artifacts 
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Clicking Apply applies the Ring-Artifact Removal according to the given settings. 

 

  

In the example above, Ring-Artifact Removal is chosen as Overlay. The Ring-
Artifact Removal overlay is displayed with yellow lines. The yellow circle defines 
the area determined by Center and Radius.  

Here, a red and a blue circle are added to visualize how the Ring-Artifact Removal 
considers each blue ring within the yellow circle. Each of these rings then build a 

centerline for a new red Window. 

For this single blue ring, the Ring-Artifact Removal filter only examines values 
within the red area. But considering window after window, the filter checks for all 

possible rings inside the yellow circle. 

The Ring-Artifact Removal calculates the variance of gray values within the blue 

ring in comparison with the average gray value inside the red window. If the variance 
is higher than the given threshold, it is assumed that there is a ring present. 

Then, the gray values of the identified ring voxels are reduced to match the average 
gray value in the red window. 

 

 

  

Window 

Before Filtered 
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SEGMENTATION & LABELING TOOLS 

In the Segmentation & Labeling tab, segment and label phases in the loaded 
image with Image Segmentation, identify and label objects in the image with the 

Watershed Image Labeling or create a surface mesh with Surface 
Triangulation. 

 

IMAGE SEGMENTATION 

The Image Segmentation panel is organized in following sections: 

◼ Global Thresholding: segment the image by setting either single or multiple 

gray-value thresholds. This is the fastest and simplest segmentation method and 
works just fine in many cases. 

◼ AI Segmentation: train a custom neural network by labeling the gray value 

voxels in the image. Although needing more time labeling the image and training 
the network, this is a very powerful tool for images that are hard to segment with 

the other methods. 

◼ Multi-Phase Segmentation: define confident areas with gray value ranges. The 
areas in between are then computed with the watershed algorithm. 

◼ Hysteresis Thresholding: accomplish edge detection using two thresholds.  

◼ Phansalkar: deal with low contrast images using this local thresholding method. 

◼ Local Otsu: automatically perform clustering-based image thresholding using 
this local thresholding method. 

 

The sementation methods Global Thresholding, AI Segmentation and Multi-
Phase Segmentation are arguably the most important segmentation methods and 

are compared in a small parameter study starting on page 102. 

GLOBAL THRESHOLDING 

There are various options for Image Segmentation via gray value thresholding. 
Up to 255 thresholds define gray value ranges, at which respective voxels are 

assigned the according material ID. 

The name for the file and folder containing the results can be entered in the Result 

File Name (*.gdr) box. Choose a name fitting the current project. 

Two Threshold Modes are available: Single Threshold and Multiple Thresholds. 
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If the segmentation settings are set as desired clicking Create Segmentation 

imports the processed image and generates a 3D model that is shown in the 
Visualization area of the GeoDict GUI. This 3D model can be saved in GeoDict Binary 

(.gdt), GeoDict ASCII (.leS) or 1 Byte integer – Binary (.raw) format by selecting 
File → Save Structure as..., in the menu bar. By default, it is saved as *.gdt in the 

generated result folder corresponding to the result file with the name chosen for 

Result File Name.  

 

Single Threshold 

The Single Threshold mode can be applied using a Manual Threshold, Otsu, or 
KMeans. For more information about the underlying theory refer to the Wikipedia 
pages Otsu’s method and KMeans clustering.  

Note that the options Visibility and Outline, which are located in the View Options 
section control the threshold visualization settings. Please refer to page 32 for more 

details. A single threshold can also be visualized in 3D as described on page 83. 

 

 

http://en.wikipedia.org/wiki/Otsu%27s_method
https://en.wikipedia.org/wiki/K-means_clustering
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Either use the Otsu or KMeans methods to automatically select a threshold based 

on the gray value distribution in the histogram or set the threshold manually with 
the Manual Threshold method.  

The value of the single Threshold separates the gray value range into two 
constituent materials. By default, Material 1 (with ID 00) is Pore and Material 2 
(with ID 01) is set to Solid while material 1 is shown in white and material 2 in red. 

For each Material, the threshold color and material selection are shown. You can 
assign each material ID the desired material phase by clicking the available button 

and following the dialog. Please refer to the Base Reference and Material Database 
handbooks of this User Guide for more details. The threshold color can be changed 
through Use GeoDict Custom Colors as explained in the View menu section on 

page 25 and the mentioned handbooks. 

The Volume Fraction gives the computed volume fraction corresponding to the 

current Threshold value, and is automatically updated, whenever threshold values 
are changed. For example, a calculated Volume Fraction of 0.36 for a Threshold 
of 125 means that 36% of the structure voxels have gray values above 125 (and are 

assigned to Material 2). 

The Density (kg/m3) of Material 2 and the selected Grammage Plane (X-Y, X-Z, 

or Y-Z) are used for the calculation of the material’s Grammage. If the density of 
the Material 2 is known, it can be entered in the spin box and GeoDict automatically 
calculates the area density for the selected plane. The density can only be set for 

Material 2, the density of Material 1 is assumed to be zero. This option is useful for 
structures like paper, which consist of one solid material and the pore space. 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=BasicVolume&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2023
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3D Gray Value Visualization in GeoDict 

As the gray value image is also visualized in the main GeoDict GUI, the image can 
also be rendered in 3D.  

The currently loaded (and processed) gray value image can be observed in 2D in the 

Visualization area. To display the image in 3D change to 3D view by clicking the  
icon in the toolbar or selecting View → 3D Rendering in the menu bar. 

 

Visualize different thresholds in 3D using the Threshold By option in the 
Visualization panel above of the Visualization area in GeoDict.  

For the threshold mode >= the dark gray values are rendered invisible in the 
visualization, when moving the threshold slider or entering a gray value number. 

Here a threshold of 122.5 is entered, which is the Otsu threshold for this image 
(122.5). For gray value images it is recommended to uncheck Smooth as this 
feature interpolates values between the voxels to show a smooth surface which can 

lead to artifacts in gray value images. 

 

 

  

3D gray value representation of a 

Berea sandstone, showing the entire 

gray value range. 

3D gray value representation of a 

Berea sandstone, showing the gray 

value range from 123-255. 

Detailed information on visualization in GeoDict can be found in the Visualization 

handbook of this User Guide. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2023
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Multiple Thresholds 

Using Multiple Thresholds, more than one threshold (for more than two different 
materials) can be defined.  

The threshold methods are: Manual Threshold, Otsu method, and KMeans-

clustering.  

 

 

 

The Otsu method is an automatic segmentation algorithm. It can be used for up to 
4 thresholds for 8bit images and up to 2 thresholds for 16bit images.  

For the Manual or KMeans thresholding, up to 255 thresholds are available.  

The automatic threshold methods (KMeans and Otsu) use only the histogram to do 
the segmentation. The Manual thresholds are selected by moving the sliders. 

Enter the Number of Thresholds to be applied in the spin box. When multiple 
thresholds are selected, these thresholds are shown in the histogram plot, at the 
bottom right of the preview areas. 

 

For an 8-bit excerpt of a Berea sandstone, four thresholds are set. The according 

five materials are shown in the histogram plot as determined by the Otsu method.  
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ImportGeo submodules – ImportGeo-Vol 

86  GeoDict 2023 User Guide 

AI SEGMENTATION 

The AI Segmentation allows to train machine learning algorithms to segment the 

complete gray value image based on user-defined labels. To accomplish this goal, 
label the image manually, train a machine learning method that learns how to 
segment the image based on the provided labels.  

The name of the file and folder containing the results can be entered in the Result 
File Name (*.gdr) box. Choose a name fitting the current project. 

 

 

AI Models 

The four different AI Models: Boosted Tree, Random Forest, Unet 2D and Unet 

3D are described in the following. 

Random Forest and Boosted Tree 

Since GeoDict 2023 the AI-segmentation via the widely used Random Forest 

method is featured additional to the Boosted Tree method. Both methods work very 
similar, but the Boosted Tree model usually is faster, since it is an advanced version 
of the Random Forest. 

Boosted Tree and Random Forest both work well for many examples and are very 
fast. For the training data, information about the neighboring voxel data are used 

and different filters are applied to the input image:  

◼ a Gauss filter blurring the image, and 

◼ a Sobel filter, emphasizing the edges.  

Define the filter parameters for these images and to which distance the neighboring 
voxels should be considered in the Select Features dialog explained below or simply 

use the default values. 
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In the figure below three filtered images are used, one with a small sigma for the 

Gauss filter, one with a larger sigma and one image filtered with the Sobol filter.  

Then, for each voxel a vector is built containing the corresponding data from the 

original image, from each of the filtered images, from the neighboring voxels, and 
from the labeled image. In the diagram below this is shown for two voxels 
exemplarily.  

The Random Forest / Boosted Tree algorithm learns from these vectors and 
segments the image.  

 

To learn more about the extraction of training data refer to [3]. 

For more information on Random Forests refer to the Wikipedia page.  

For detailed theory about the Boosted Tree model see [4], [5], [6] and [7]. 

In case of big-scaled relevant features, the Random Forest and Boosted Tree 

methods can be limited. That is because the decision for each pixel depends on the 
surroundings, especially on the Gauss kernel of a fixed size. If e.g., the image has 

pores of different materials but with a similar gray value and the only difference is 
the border to the solid material, for big pores the boosted tree method could decide 
wrong. In such cases, the Unet methods are recommended. Also, if more than two 

materials are in the structure, they can be limited and the Unet method is preferable. 

  

https://en.wikipedia.org/wiki/Random_forest
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Clicking on the gearwheel icon  accesses the parameters defining the model 
setup. The Set Model Parameters dialog opens. 

Following parameters can be set for the Boosted Tree model:  

◼ Number of Trees: Defines the number of parallel trees constructed during each 
iteration. More trees result in a higher learning ability but can lead to overfitting. 
An overfit model has no good generalization ability. 

◼ Maximum Depth: Maximum depth of a tree. Increasing this value will make the 
model more complex and more likely to overfit.  

◼ Learning Rate: The learning rate is a step size shrinkage used in each update 

to prevent overfitting. The learning rate must be >0 and ≤1. The lower the 

learning rate, the longer the runtime but the higher the generalization ability of 
the final model. 

◼ Minimum Split Loss: Minimum loss reduction required to make a further 
partition on a leaf node of the tree. The larger the minimum split loss, the more 
conservative the algorithm will be. 

 

Following parameters can be set for the Random Forest model:  

◼ Number of Trees: Defines the number of parallel trees in the forest constructed 
during each iteration. More trees result in a higher learning ability but can lead 
to overfitting. An overfit model has no good generalization ability. 

◼ Maximum Depth: Maximum depth of a tree. Increasing this value will make the 
model more complex and more likely to overfit.  

◼ Minimum Samples Split: Minimum number of samples required to split an 
internal node. The larger the minimum samples split value, the more 

conservative the algorithm will be. 
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For Boosted Tree and Random Forest it is also possible to Select Features. 

Select Features controls the parameters for the applied filters for the Boosted Tree 
and the Random Forest methods. These filtered images are considered in the training 

of the model as shown in the figure above to gain more information for each voxel. 
They are used also in the segmentation, but only as a reference for the model, since 
they can help to find out which label is correct for which voxel in the original image. 

These filters always were applied for Boosted Tree with the current default settings, 
but since GeoDict 2023 their parameters can be changed by the user.  

Check the features that should be used and enter a list of parameters for the feature 
runs, separated by “;”.  

◼ The Neighbor method has the parameters Distances and Directions. For the 

default settings, the neighborhood is examined three times with a distance of 1 
voxel – once for each direction. The voxels in the neighborhood within the given 
distance are considered as information for how the current voxel should be 

labeled. 

◼ The Gauss filter has the parameter Sigmas. Sigma is the standard deviation for 
the Gauss function used for this filter. For the default settings this filter is run 

twice, once for a sigma of 1 and once for a sigma of 3. The higher the standard 
deviation, the more the image is blurred. This filter can also be found under the 
Image Processing tools, as described on page 62. 

◼ The Sobel filter has the parameter Directions. In the default settings, it is 
applied in all three directions. This filter emphasizes the edges. This filter is 
similar to the Compute Gradient filter described on page 66. 
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Unet 

The deep learning methods Unet 2D and Unet 3D require more training data. Thus, 
more labels must be provided manually. Then, they are more capable to analyze the 
scan correctly and thus, achieve better results.  

The name Unet refers to the U-shape of the neural network diagram, consisting of 
a constricting branch on the left and an expanding branch on the right. The number 

of layers in each branch define the depth of the Unet. 

 

For more detailed theory about the Unet models and the underlying architecture 
refer to the paper [8] or the GeoDict-AI User Guide. 

To use the Unet models a good graphics card is needed, i.e., a good NVIDIA 

graphics card (GPU) with compute capability of at least 3.5. Please make sure 
drivers are installed and up to date. See more information on graphics cards in 

https://developer.nvidia.com/cuda-gpus. This webpage contains a helpful section 
with Frequently Asked Questions. 

For Linux, the Gnu C Library (glibc) must be at least version 2.27. We recommend 

Ubuntu 20.04 LTS, but for a current glibc other Linux distributions should also 
work.  

Unet 3D considers the complete image, while Unet 2D learns from the single slices 
in the specified direction. The default is the Z-direction. 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoDictAI&release=2023
https://developer.nvidia.com/cuda-gpus
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Clicking on the gearwheel icon  accesses the parameters defining the model 
setup. The Set Model Parameters dialog opens. Following parameters can be set 
for the Unet model:  

◼ Window Size X, Y and Z: For the training, the Unet algorithm subdivides the 
gray value image into windows of the given size in voxels. A bigger window size 
requires more training data and time, but the learning potential increases. The 

windows are placed according to the given Stride or around every labeled voxel. 

◼ Number of Epochs: The number of 
times, the training data is used to train 

the neural network. For more epochs, 
the learning time grows linearly, but the 

learning potential increases. Too many 
epochs, however, can lead to 
overfitting. 

◼ Depth of the Unet: The number of 
levels in a Unet. A higher depth requires 
more training data and increases 

runtime and GPU memory, but the 
learning potential increases.  

◼ Number of Features in First Layer: 
The number of features that the model 
can learn in the first layer. More 
features require more training data and 

time, but the learning potential 
increases. 

◼ Use Strides: Use a window stride 
defined by the values Stride X, Y and 
Z. These strides determine how many 

voxels the window is moved for each new training sample, starting in the upper 
left corner. Then, only the windows containing labeled voxels are taken into 
account. If not checked windows around every labeled voxel are used for the 

training. 

Unet 2D means that the windows determined by Window Size are 2D slices, i.e., 

one of the three Window Size parameters is 1. The default for Window Size Z = 
1 usually leads to good results. If all three size parameters are greater than 1, 
automatically the Unet 3D model is applied. 

Comparison of Boosted Tree/Random Forest and Unet 

In the following table, the two learning methods are compared directly. 

 

Boosted Tree and Random Forest Unet2D and 3D 

Fast training Computationally expensive (require GPU for 

interactive work) 

Can work with very little training data Require more manual labels 

Limited when scale of relevant features 

gets big 

Can learn more 
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Label Image Data 

For all three models choose the Number of Materials to be labeled in the scan.  

 

Specify the different materials with the material data base. The checkbox next to the 
material boxes determines the current material for painting the labels.  

The Navigation Mode  allows to pan the image in the 2D Slice Visualization 
section with the left mouse button and zoom in and out with the right mouse button. 

Select the Painting Mode  to paint in the 2D Slice Visualization area. Ensure 
to have the Visibility turned on as described on page 32ff and AI-Labels selected 
for Overlay as described on page 31. The Painting Mode allows to paint labels on 

the scan with the left mouse button. Switch between the materials by selecting the 
corresponding checkboxes. Pressing and holding shift, the navigation in the 2D Slice 

Visualization section works the same as in the Navigation Mode. 

 

Make sure to have approximately the same amount of labeled area for the different 

materials, especially for the Unet models. Validate this in the Label Data tab of the 
Histogram section, described on page 38. 

If a label was not painted correctly switch to the Erasing Mode  and erase 
labels in the 2D Visualization section. 

Change the Brush Size fitting to the areas to label. 

 

In the different view directions, observe the already existing labels from the slices 

labeled in the other two directions, respectively.  
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In the example on the right the center slice in X- and 

Y-direction got labeled. Thus, if viewed in Z-direction, 
two thin lines with white (material 1) and red (material 

2) sections are already labeled. If labels are erased on 
these lines, in the respective slices in the other 
directions thin lines are erased. This leads to less 

trainings data.  

 

 

 

 

 

 

 

 

If there are more than two materials, it is important to label boundaries for the 

different boundary combinations.  

Labels close to each other give better results. For each labeled area paint as many 

labels as possible to get a fully filled output window. 

While it can be important to label boundaries, only label as near to the boundary as 
it can be ensured to label it correctly. Otherwise, wrong training data will be 

generated. Paint in all three directions, especially if the gray values differ much. 

Especially for the Unet3D method ensure to label some consecutive slices in the 

same areas. 
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The provided labels can be saved as *.gld file by clicking Save Labels. Load the 

training data again whenever needed by clicking Load Labels. Delete all labels by 
clicking Clear Labels. 

 

If a trained model is loaded, the Overlay can also be set to Preview to preview the 
segmentation results for the current slices as shown on page 95. If changing the 

Overlay to Mixed, both the current labels and the preview of the current model can 
be viewed. If the preview shows that the model needs more training, using the mixed 

view helps to concentrate the further labeling on the areas, where the network did 
not classify the voxels correctly. 
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Train and apply neural network 

If enough labels are painted click Train to train a machine learning model.  

Afterwards select Preview to control the resulting segmentation. The Overlay is 
switched to Preview. 

 

In the example above the Boosted Tree method was used. Thus, only few labels 
are needed for this gray value image of a Berea sandstone. 

A previously loaded model can be improved by clicking Continue Train. A model is 
loaded either by training it before in the current Image Processing session or by 
loading a previously trained model by clicking Load Model.  

For example, with more labeled gray values, Continue Train can improve the 
model. Note that not only the new labels are considered, but also the labels used for 

the loaded model to use all available information for the training.  

Additionally, a model can be improved if another similar image is loaded and labeled 
to provide more training data.  

Click Save Model to save a machine learning model trained by clicking Train. This 
model can be loaded again by clicking Load Model whenever similar scans have to 

be segmented. For the three different AI models the formats are *.XGBM for 
Boosted Tree, *.UNET2D for Unet 2D, or *.UNET3D for Unet 3D. 

 

Finally, clicking Create Segmentation applies the model for each slice.  
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MULTI-PHASE SEGMENTATION 

For more than two materials, the Multi-Phase Segmentation often leads to better 

results than the Multiple Thresholds method.  

If there are bright artifacts at the borders between the different materials or the 
contrast is low, the Multi-Phase Segmentation can be used to fill these uncertain 

regions based on the watershed algorithm. Thus, it is very useful to avoid partial 
volume effects. 

The name of the file and folder containing the results can be entered in the Result 
File Name (*.gdr) box. Choose a name fitting the current project. 

Select the Number of Phases between 2 and 15. 

Choose the materials for the different phases from the material data base. 

 

 

 

 

 

 

 

 

 

 

 

 

Define gray value ranges that are assigned to certain phases, by move the sliders to 

define the Range for the different phases. The higher value of each phase must be 
smaller than the lower range value of the next phase. If equal, the gray value is 
assigned to the next phase. For example, if Range 1 is defined as 20-50 and Range 

2 is 50-70, the gray value 50 is assigned to Material 2.  

All remaining uncertain areas, i.e., the gray values that are not contained in any 

defined range, are filled using the watershed algorithm. The watershed algorithm is 
described on pages 67ff. 

Finally, clicking Create Segmentation applies the multi-phase segmentation to the 

image.  

In the following example the gray values are split in three phases. Material 1 is set 

to solid with a definite gray value range of 0-80. The second phase is defined as pore 
space with Range 2 set to 90-100. The main solid material is defined in phase 3 
with Range 3 of 130-255. Thus, the gray values 81-89 and 101-129 are not sorted 

to one of the two phases, as can also be observed in the 2D Slice Visualization 
section, if Visibility is turned on. The gray values in range 1 are marked in white, 

the gray values in range 2 in red and the gray values in range 3 in green. All other 
gray values are not marked. After creating the segmentation these are filled using 
the watershed algorithm.  
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HYSTERESIS THRESHOLDING 

The name for the file and folder containing the results can be entered in the Result 

File Name (*.gdr) box. Choose a name fitting the current project. 

Thresholding with Hysteresis selected as Method is one way to accomplish edge 
detection using two thresholds.  

 

 

 

It implements the detection of edges by suppressing all the other edges that are 
weak and not connected to strong edges. Low thresholded edges which are 
connected to high thresholded edges are retained. Low thresholded edges which are 

non-connected to high thresholded edges are removed. 

This leads to the creation of 3 classes: below low threshold (to be removed), above 

high threshold (to be retained), and between low and high thresholds (to be retained 
only if connected to an edge above high threshold).  

Finally, clicking Create Segmentation applies the hysteresis thresholding to the 
image.  
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PHANSALKAR 

The Phansalkar filter is a modification of [9] and deals with low contrast images. 

For detailed information about the theory also refer to [10]. 

 

The Sphere Radius controls the size of the region, in which the filter is applied. 

The local threshold T is found from the mean (m) and standard deviation (s) of the 

pixel intensities as follows: 

𝑇 = 𝑚 [1 + 𝒑𝑒−𝒒 𝑚 +  𝑲 ( 
𝑠

𝑅
− 1)] 

R is the dynamic range of standard deviation, which is equal to 0.5 for a normalized 
image, and K is a constant which takes values in the range [0.2, 0.5]. p and q are 

constants. 

The local mean and standard deviation adapt the value of the local threshold. 

Click Create Segmentation to segment the gray value image with the Phansalkar 
method. This thresholding method does not create a GeoDict result file. The resulting 
structure is displayed in the GeoDict visualization area. The gray value image stays 

in memory and can be compared to the structure. Check Structure and uncheck 
Volume Field in the visualization panel above of the visualization area to only 

visualize the structure. 

To save the structure in a *.gdt file select File → Save Structure as … from the 

menu bar in the main GeoDict GUI. 
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LOCAL OTSU 

The Local Otsu method is used in image processing to automatically perform 

clustering-based image thresholding. It reduces the grayscale image to a binary 
image. A global Otsu thresholding is available and explained in the Image 
Segmentation chapter on page 81.  

The Local Otsu method circumvents potential irregularities in the complete 3D 
image by focusing on smaller cubes with edge length in voxels according to the 

assigned Window Size.  

The parameter Sample Length defines the distance between these 3D regions and 
can be set automatically by clicking Suggest Sample Rate.  

The Lower and Upper Cut Threshold can be adjusted to reduce noise in bright or 
dark regions. Depending on sample rate and window size, multiple thresholds are 

applied for assigning each voxel to the according phase. 

Click Create Segmentation to segment the gray value image with the Local Otsu 

method. This thresholding method does not create a GeoDict result file. The resulting 
structure is displayed in the GeoDict visualization area. The gray value image stays 
in memory and can be compared to the structure. Check Structure and uncheck 

Volume Field in the visualization panel above of the visualization area to only 
visualize the structure.  

 

 

To save the structure in a *.gdt file select File → Save Structure as … from the 

menu bar in the main GeoDict GUI. 
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RESULTS 

After clicking Create Segmentation for one of the segmentation methods, the 

segmentation is applied for the gray value image. The generated result file with the 
name entered for Result File Name is opened automatically in the result viewer.  

The Report tab lists some basic Structure Information for the resulting structure 

and all steps done in the Image Processing dialog e.g. including Segmentation 
methods and the used Image Filters. 

 

Additional to the result file, a result folder with the same name is saved inside the 

current project folder, containing the segmented structure file (*.gdt). 

For a more detailed description of the Result Viewer options refer to the Result Viewer 
handbook of this User Guide. 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
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COMPARISON OF DIFFERENT SEGMENTATION METHODS  

To compare the different segmentation methods, the Berea sandstone is segmented 

with Global Thresholding, Multi-Phase Segmentation and AI Segmentation. 

The segmentation methods 

Global Thresholding Multi-Phase 

Segmentation 

AI Segmentation 

 

  

Single or Multiple gray value 

thresholds 

Automatic thresholding based 

on gray value histogram (e.g., 

OTSU) 

 

Define gray value ranges 

for phases 

Any remaining “uncertain” 

areas are automatically 

segmented via Watershed 

 

Label multiple materials 

manually 

Fast Machine Learning-

based Training algorithm 

Deep learning-based 

Training algorithm 

(UNet2D, UNet3D) 

The sample 

Berea Sandstone 

Andrae et al. ([1],[11]) 

▪ Dimensions: 

720x720x1024 voxels 

▪ Resolution: 0.74 µm 

▪ Components: Quartz,  

Feldspar, Calcite, Zircon 
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The segmentation 

For the Berea sandstone a parameter study was done comparing published 
experimental data to GeoDict results. Segmented porosity and computed (absolute) 
permeability are determined for the different segmentation methods. The results 

showed that (in this case) the Non-Local Means Filter (NLM), described on page 
61) was not needed for the AI Segmentation, but for the other two methods. Instead, 

after segmentation any remaining small-scaled features were reassigned with the 
ProcessGeo Cleanse feature. 

 

The segmentation results for the different methods applied to the Berea sandstone 

look as follows: 

 

In a visual comparison, the Global Thresholding result appears to be very similar 

to the AI Segmentation. The Multi-Phase Segmentation removes a major part 
of small-scale features. Thus, a reduced porosity is to be expected for this particular 

result.  

The comparison study shows that all the above segmentation results are within 
experimentally obtained data. Consecutive flow computations performed via the 

FlowDict module result in (absolute) permeability values that are very well in the 
range of lab data published by Andrä et al (2013b). The entire study “Impact of 

different segmentation methods on Digital Rock Analysis results” was presented at 
the iRIS conference (international Rock Imaging Summit) in 2020 and is available 
from the GeoDict webpage here. 

Original gray values Non-Local Means (NLM) Filter 

Smoothed noise, sharp edges 

AI-based Segmentation + 

ProcessGeo - Cleanse 

NLM + 

Single Threshold (Otsu) 

NLM + 

Multi-Phase Segmentation 

http://dx.doi.org/10.1016/j.cageo.2012.09.008
https://www.geodict.com/Showroom/presentations.php?year=All&event=All&topic=Machine%20learning&input=
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WATERSHED IMAGE LABELING 

The Watershed Image Labeling creates a *.g32 index image from the gray value 
image. Thus, the result could be used e.g., in GrainFind to reconnect oversegmented 

objects and obtain grain statistics, as described in the GrainFind handbook of this 
User Guide.  

 

 

The name for the file and folder containing the results can be entered in the Result 

File Name (*.gdr) box. The default name can be kept, or a new name can be 
chosen, fitting the current project.  

 

The parameters and the results are the same as for the Watershed (Supervoxel) 
image filter described on pages 67ff.  

Additionally, it can be selected to label components as background. The background 
components are labeled with index 0.  

If Filter Background Components by Threshold is selected, the watershed 

components with a mean gray value lower than the threshold given for Background 
Threshold are considered as background. 

If Filter Background Components by Size is selected, the watershed components 
that consist of less voxels than the given Number of Voxels are considered as 

background.  

Check both background component filters to label the components as background, 
that have a mean gray value lower than the given threshold, as well as consisting of 

less voxels than the given number of voxels. 

Click Apply to run the Watershed Image Labeling process.  

 

While the Watershed (Supervoxel) changes the image in the 2D Slice 
Visualization section, the Watershed Image Labeling does not. Load the results 

from the Result Viewer as explained on page 70. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GrainFind&release=2023&heading=IdentifyGrains&heading=LoadGrainFindResults
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In the following example the same image as for the Watershed (Supervoxel) filter 

is considered. For the Watershed Labeling the same parameters are used. 
Additionally, Filter Background Components by Threshold was checked and a 

Background Threshold of 120.5 was entered. Thus, all components with a gray-
value lower than 120.5 were assigned to index 0, which is colored in white.  
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SURFACE TRIANGULATION 

Create a Surface Triangulation for the resulting structure by creating a Surface 
Mesh. This feature only is available if the user owns a ExportGeo-Cad license.  

The structure is segmented into two phases and the iso surface wraps around the 
high gray value values which are assigned to Material ID 01 with normal pointing 
into the pore space which is assigned to Material 

ID 00. 

 

Segment the gray value image either with an Automatic Threshold or with a 
manual threshold entered for Threshold. 

If Automatic Threshold is enabled, the Otsu method is used to threshold the 
image. 

When Add to current mesh is selected and a mesh is already in memory, the new 

mesh is added to that mesh. Multiple meshes can then be edited together and be 
saved to a single file.  

If Coarsen during creation is checked, the number of triangles in the generated 
surface mesh is reduced.  

Three different modes to coarsen triangulations are provided, based on the stopping 
criteria for the coarsening algorithm: by Percentage Reduction of Triangles, by 
Edge Length, and by Target Number of Triangles.  

The coarsening algorithm reduces the number of triangles in the generated mesh by 
combining short edges to longer edges.  

For a detailed description and examples for the triangulation parameters see the 
ExportGeo-CAD & MeshGeo handbook of the GeoDict User Guide. 

Click Surface Triangulation to start the process. After the triangulation is finished, 

the resulting mesh is displayed in the GeoDict visualization area.

Example: Surface Triangulation of a 

Berea sandstone, 180x180x256 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoCADMeshGeo&release=2023&heading=ExportVoxelMesh
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